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C H A P T E R 1
New and Changed Information

• New and Changed Features, on page 1

New and Changed Features
The following table summarizes the new and changed features and provides information about where they
are documented.

Table 1: New and Changed Features for Cisco DNA Center, Release 2.3.3.3

Where DocumentedDescriptionFeature

• Solution
Components, on
page 4

• Supported Platforms,
on page 5

• Supported Network
Design, on page 6

CiscoDNAService for Bonjour supports CiscoNexus
9000 Series Switches as an SDG agent in multicast
mode.

Support for Cisco Nexus
9000 Series Switches
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C H A P T E R 2
Cisco DNA Service for Bonjour Solution
Overview

• About the Cisco DNA Service for Bonjour Solution, on page 3
• Solution Components, on page 4
• Supported Platforms, on page 5
• Supported Network Design, on page 6

About the Cisco DNA Service for Bonjour Solution
The Apple Bonjour protocol is a zero-configuration solution that simplifies rich services and enables intuitive
experience between connected devices, services, and applications. Using Bonjour, you can discover and use
IT-managed, peer-to-peer, audio and video, or Internet of Things (IoT) services with minimal intervention
and technical knowledge. Bonjour is originally designed for single Layer 2 small to mid-size networks, such
as home or branch networks. The Cisco DNA Service for Bonjour solution eliminates the single Layer 2
domain constraint and expands the matrix to enterprise-grade traditional wired and wireless networks, including
overlay networks such as Cisco Software-Defined Access (SD-Access) and industry-standard BGP EVPN
with VXLAN. The Cisco Catalyst 9000 Series LAN switches, Cisco Nexus 9300 Series Switches, and Cisco
Catalyst 9800 SeriesWireless Controller follow the industry standard, RFC 6762-basedmulticast DNS (mDNS)
specification to support interoperability with various compatible wired and wireless consumer products in
enterprise networks.

The Cisco Wide Area Bonjour application on Cisco DNA Center enables mDNS service routing to advertise
and discover services across enterprise-grade wired and wireless networks. The new-distributed architecture
is designed to eliminate mDNS flood boundaries and transition to unicast-based service routing, providing
policy enforcement points and enabling the management of Bonjour services.

The following figure illustrates how the Cisco Wide Area Bonjour application operates across two integrated
service-routing domains.

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
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Figure 1: Cisco Wide Area Bonjour Solution Architecture

• Local Area Service Discovery Gateway Domain - Unicast Mode: The new enhanced Layer 2 unicast
policy-based deployment model. The new mDNS service discovery and distribution using the Layer 2
unicast address enables flood-free LAN and wireless networks. Cisco Catalyst 9000 Series Switches and
Cisco Catalyst 9800 Series Wireless Controller in Layer 2 mode introduce a new service-peer role,
replacing the classic flood-n-learn, for new unicast-based service routing support in the network. The
service-peer switch and wireless controller also replace mDNS flood-n-learn with unicast-based
communication with any RFC 6762 mDNS-compatible wired and wireless endpoints.

• Wide-Area Service Discovery Gateway Domain: TheWide Area Bonjour domain is a controller-based
solution. The Bonjour gateway role and responsibilities of Cisco Catalyst and Cisco Nexus 9300 Series
Switches are extended from a single SDG switch to an SDG agent, enabling Wide Area Bonjour service
routing beyond a single IP gateway. The network-wide distributed SDG agent devices establish a
lightweight, stateful, and reliable communication channel with a centralized Cisco DNACenter controller
running the Cisco Wide Area Bonjour application. The SDG agents route locally discovered services
based on the export policy.

The classic Layer 2 multicast flood-n-learn continues to be supported on wired
and wireless networks with certain restrictions to support enhanced security and
location-based policy enforcement. The Cisco Catalyst and Cisco Nexus 9300
Series Switches at Layer 3 boundary function as an SDG to discover and distribute
services between local wired or wireless VLANs based on applied policies.

Note

Solution Components
The Cisco DNA Service for Bonjour solution is an end-to-end solution that includes the following key
components and system roles to enable unicast-based service routing across the local area and Wide Area
Bonjour domain:

• Cisco Service Peer: Cisco Catalyst Switches and Cisco Wireless Controllers in Layer 2 access function
in service peer mode to support unicast-based communication with local attached endpoints and export
service information to the upstream Cisco Catalyst SDG agent in the distribution layer.

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
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Cisco Nexus 9300 Series Switches don't support unicast-based service routing
with downstream Layer 2 access network devices.

Note

• Cisco SDG Agent: Cisco Catalyst and Cisco Nexus 9300 Series Switches function as an SDG agent and
communicate with the Bonjour service endpoints in Layer 3 access mode. At the distribution layer, the
SDG agent aggregates information from the downstreamCisco service peer switch and wireless controller,
or local Layer 2 networks, and exports information to the central Cisco DNA controller.

Cisco Nexus 9300 Series Switches don't support multilayer LAN-unicast
deployment mode.

Note

• Cisco DNA controller: The Cisco DNA controller builds the Wide Area Bonjour domain with
network-wide and distributed trusted SDG agents using a secure communication channel for centralized
services management and controlled service routing.

• Endpoints: A Bonjour endpoint is any device that advertises or queries Bonjour services conforming to
RFC 6762. The Bonjour endpoints can be in either LANs or WLANs. The Cisco Wide Area Bonjour
application is designed to integrate with RFC 6762-compliant Bonjour services, including AirPlay,
Google Chrome cast, AirPrint, and so on.

Supported Platforms
The following table lists the supported controllers, along with the supported hardware and software versions.

Table 2: Supported Controllers with Supported Hardware and Software Versions

Software VersionHardwareSupported Controller

Cisco DNACenter, Release 2.3.2.3DN2-HW-APL

DN2-HW-APL-L

DN2-HW-APL-XL

Cisco DNA Center appliance

2.4.264.12003—Cisco Wide Area Bonjour
application

The following table lists the supported SDG agents along with their licenses and software requirements.

Table 3: Supported SDG Agents with Supported License and Software Requirements

Minimum SoftwareWide Area SDGLocal Area SDGSupported RoleSupported Platform

Cisco IOS XE
Bengaluru 17.6.2

UnsupportedCisco DNA
Advantage

SDG agentCisco Catalyst 9200
Series Switches

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
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Minimum SoftwareWide Area SDGLocal Area SDGSupported RoleSupported Platform

—UnsupportedUnsupported—Cisco Catalyst
9200L Series
Switches

Cisco IOS XE
Bengaluru 17.6.2

Cisco DNA
Advantage

Cisco DNA
Advantage

Service peer

SDG agent

Cisco Catalyst 9300
Series Switches

Cisco IOS XE
Bengaluru 17.6.2

Cisco DNA
Advantage

Cisco DNA
Advantage

Service peer

SDG agent

Cisco Catalyst 9400
Series Switches

Cisco IOS XE
Bengaluru 17.6.2

Cisco DNA
Advantage

Cisco DNA
Advantage

Service peer

SDG agent

Cisco Catalyst 9500
Series Switches

Cisco IOS XE
Bengaluru 17.6.2

Cisco DNA
Advantage

Cisco DNA
Advantage

Service peer

SDG agent

Cisco Catalyst 9500
High Performance
Series Switches

Cisco IOS XE
Bengaluru 17.6.2

Cisco DNA
Advantage

Cisco DNA
Advantage

Service peer

SDG agent

Cisco Catalyst 9600
Series Switches

Cisco IOS XE
Bengaluru 17.6.2

UnsupportedCisco DNA
Advantage

Service peerCisco Catalyst 9800
Wireless Controller

Cisco IOS XE
Bengaluru 17.6.2

UnsupportedCisco DNA
Advantage

Service peerCisco Catalyst
9800-L Wireless
Controller

Cisco NX-OS
Release 10.2(3)F

Cisco DNA
Advantage

Cisco DNA
Advantage

SDG agentCisco Nexus 9300
Series Switches

Supported Network Design
The Cisco DNA Service for Bonjour supports a broad range of enterprise-grade networks. The end-to-end
unicast-based Bonjour service routing is supported on traditional, Cisco SD-Access, and BGP EVPN-enabled
wired and wireless networks.

Traditional Wired and Wireless Networks
Traditional networks are classic Layer 2 or Layer 3 networks for wired and wireless modes deployed in
enterprise networks. Cisco DNA Service for Bonjour supports a broad range of network designs to enable
end-to-end service routing and replace flood-n-learn-based deployment with a unicast mode-based solution.

The following figure illustrates traditional LAN and central-switching wireless local mode network designs
that are commonly deployed in an enterprise.

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
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Figure 2: Enterprise Traditional LAN and Wireless Local Mode Network Design

Wired Networks
The following figure shows the supported traditional LAN network designs that are commonly deployed in
an enterprise.

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
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Figure 3: Enterprise Wired Multilayer and Routed Access Network Design

The Cisco Catalyst or Cisco Nexus 9300 Series Switches in SDG agent role that provide Bonjour gateway
functions are typically IP gateways for wired endpoints that could reside in the distribution layer in multilayer
network designs, or in the access layer in Layer 3 routed access network designs:

• Multilayer LAN—Unicast Mode: In this deployment mode, the Layer 2 access switch provides the
first-hop mDNS gateway function to locally attached wired endpoints. In unicast mode, the mDNS
services are routed to the distribution layer systems providing IP gateway and SDG agent mode. The
policy-based service routing between the SDG agents is performed by the Cisco DNA Center controller.

• Multilayer LAN—Flood-n-Learn Mode: In this deployment mode, the Layer 2 access switch or wireless
controller are in mDNS passthroughmodes with the Cisco Catalyst or Cisco Nexus 9300 Series Switches
operating in the SDG agent mode. ThemDNS gateway function at distribution layer in a network enables
inter-VLAN mDNS local proxy. It also builds stateful Wide Area Bonjour unicast service routing with
the Cisco DNA Center to discover or distribute mDNS services beyond a single IP gateway.

• Routed Access: In this deployment mode, the first-hop Cisco Catalyst or Cisco Nexus 9300 Series Switch
is an IP gateway boundary and, therefore, it must also perform the SDG agent role. The policy-based
service routing between the SDG agents is performed by the Cisco DNA Center controller.

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
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Wireless Networks
The Cisco DNA Service for Bonjour extends the single wireless controller mDNS gateway function into the
Wide Area Bonjour solution. The mDNS gateway on Cisco Catalyst 9800 Series Wireless Controller can be
deployed in an enhanced mode as a service peer. In this mode, the wireless controller builds unicast service
routing with an upstream Cisco Catalyst gateway switch for end-to-end mDNS service discovery. It replaces
the classic flood-n-learn mDNS services from wired network using mDNS AP or other methods.

The following figure shows the supported traditional wireless LAN network designs that are commonly
deployed in an enterprise. Based on the wireless network design, the mDNS gateway function may be on the
wireless controller, or first-hop Layer 2 or Layer 3 Ethernet switch of an Access Point in local-switching
mode.

Figure 4: Enterprise Traditional Wireless LAN Network Design

The Cisco DNA Service for Bonjour supports the following modes for wireless LAN networks:

• Local Mode: In the central switching wireless deployment mode, the m-DNS traffic from local mode
Cisco access points is terminated on the Cisco Catalyst 9800 Series Wireless Controller. The Cisco
Catalyst 9800 Series Wireless Controller extends the mDNS gateway function to the new service peer
mode. The wireless controller can discover and distribute services to local wireless users and perform
unicast service routing over a wireless management interface to the upstream Cisco Catalyst Switch in
the distribution layer, which acts as the IP gateway and the SDG agent.

• FlexConnect—Central: The mDNS gateway function for Cisco access point in FlexConnect central
switch SSID functions consistently as described in Local Mode. The new extended mDNS gateway
mode on the CiscoWireless Controller and upstream service routing with SDG agent operate consistently
to discover services across network based on policies and locations.

• FlexConnect—Local: In FlexConnect local switchingmode, the Layer 2 access switch inmDNS gateway
service peer mode provides the policy-based mDNS gateway function to locally attached wired and
wireless users. The Cisco Catalyst Switches in the distribution layer function as SDG agents and enable

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
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mDNS service-routing across all Layer 2 ethernet switches to support unicast-based service routing to
LAN and wireless LAN user groups.

• Embedded Wireless Controller—Access Point: The Layer 2 access switch in service peer mode
provides unifiedmDNS gateway function to wired andwireless endpoints associatedwith Cisco Embedded
Wireless Controller on Cisco Catalyst 9100 Series Access Points. The SDG agent in the distribution
layer provides unicast service routing across all Layer 2 service peer switches in the Layer 2 network
block without any mDNS flooding.

Cisco SD-Access Wired and Wireless Networks
Cisco SD-Access-enabled wired and wireless networks support Cisco DNA Service for Bonjour across fabric
networks. The Cisco Catalyst 9000 Series Switches support VRF-aware Wide Area Bonjour service routing
to provide secure and segmented mDNS service discovery and distribution management for virtual networks.
The VRF-aware unicast service routing eliminates the need to extend Layer 2 flooding, and improves the
scale and performance of the fabric core network and endpoints.

Figure 5: Cisco SD-Access Wired and Wireless Network Design

Cisco SD-Access supports flexible wired and wireless network design alternatives to manage fully distributed,
integrated, and backward-compatible traditional network infrastructure. Wide Area Bonjour service routing
is supported in all network designs providing intuitive user experience. The following figure illustrates the
various SD-Access enabled wired and wireless network design alternatives.

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
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Figure 6: Cisco SD-Access Wired and Wireless Network Design Alternatives

The Cisco DNA Service for Bonjour for SD-Access enabled wired and fabric, or traditional mode-wireless
networks use two-tier service routing providing end-to-end unicast-based mDNS solution. Based on the
network design, each solution component is enabled in a unique role to support theWide Area Bonjour domain:

• Fabric Edge SDG Agent: The Layer 3 Cisco Catalyst Fabric Edge switch in the access layer configured
as SDG agent provides unicast-based mDNS gateway function to the locally attached wired and wireless
endpoints. The VRF-aware mDNS service policy provides network service security and segmentation
in a virtual network environment. The mDNS services can be locally distributed and routed through
centralized Cisco DNA Center.

• Policy Extended Node: The Layer 2 Cisco Catalyst access layer switch enables first-hop mDNS gateway
function without flooding across the Layer 2 broadcast domain. The unicast-based service routing with
upstream Fabric Edge switch in the distribution layer enables mDNS service routing within the same
Layer 2 network block. It can also perform remote service discovery and distribution from centralized
Cisco DNA Center.

• Cisco Wireless Controller: Based on the followingwireless deploymentmodes, CiscoWireless Controller
supports unique function to enable mDNS service routing in Cisco SD-Access enabled network:

• Fabric-Enabled Wireless: CiscoWireless Controller doesn't require any mDNS gateway capability
to be enabled in distributed fabric-enabled wireless deployments.

• Local Mode Wireless: As Cisco Wireless Controller provides central control and data plane
termination, it provides mDNS gateway in service peer mode for wireless endpoints. The wireless
controller providesmDNS gateway between locally associatedwireless clients. Thewireless controller
builds service routing with upstream SDG agent Catalyst switch providing IP gateway and service
routing function for wireless endpoints.

• Embedded Wireless Controller—Switch: The Cisco Embedded Wireless Controller solution
enables the lightweight integrated wireless controller function within the Cisco Catalyst 9300 Series

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
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Switch. The Cisco Catalyst switches in the distribution layer function as SDG agents to the wired
and wireless endpoints. The SDG agent in the distribution layer provides unicast service routing
across all wireless access points and Layer 2 service peer switches without mDNS flooding.

• Cisco DNA Center Controller: The CiscoWideArea Bonjour application on CiscoDNACenter supports
policy and location-based service discovery, and distribution between network-wide distributed Fabric
Edge switches in SDG agent mode.

TheWide Area Bonjour communication between the SDG agent and controller takes place through the network
underlay. Based on policies, the SDG agent forwards the endpoint announcements or queries to the Cisco
DNA Center. After discovering a service, the endpoints can establish direct unicast communication through
the fabric overlay in the same virtual network. The inter-virtual network unicast communication takes place
through the Fusion router or external Firewall system. This communication is subject to the configured overlay
IP routing and Security Group Tag (SGT) policies.

BGP EVPN Networks
The BGP EVPN-based technology provides a flexible Layer 3 segmentation and Layer 2 extension overlay
network. The VRF and EVPN VXLAN-aware Wide Area Bonjour service routing provides secure and
segmented mDNS service solution. The overlay networks eliminate mDNS flooding over EVPN-enabled
Layer 2 extended networks and solve the service reachability challenges for Layer 3 segmented routed networks
in the fabric.

The following figure shows the BGP EVPN leaf switch in the distribution layer, supporting overlay Bonjour
service routing for a BGP EVPN-enabled traditional Layer 2 wired access switch and traditional wireless
local mode enterprise network interconnected through various types of Layer 2 networks and Layer 3 segmented
VRF-enabled networks.

Figure 7: Overlay Bonjour Service for a BGP EVPN-Enabled Enterprise Network

Cisco DNAService for Bonjour supports all the industry-standard overlay network designs enabling end-to-end
unicast-based mDNS service routing, and preventing flooding and service boundary limitation across wired
and wireless networks.

The following figure illustrates the various BGP EVPNVXLAN reference overlay network design alternatives.
This network design enables end-to-end mDNS service discovery and distribution based on overlay network
policies.

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
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Figure 8: BGP EVPN VXLAN Wired and Wireless Design Alternatives

The Cisco Catalyst and Cisco Nexus 9000 Series Switches can be deployed in Layer 2 or Layer 3 leaf roles
supportingmDNS service routing for a broad range of overlay networks. In any role, the mDNS communication
is limited locally and supports end-to-end unicast-based service routing across Wide Area Bonjour domain:

• Layer 2 Leaf SDG Agent: The Cisco Catalyst or Cisco Nexus switches can be deployed as Layer 2 leaf
supporting end-to-end bridged network with IP gateway within or beyond BGP EVPN VXLAN fabric
network. By default, the mDNS is flooded as Broadcast, Unknown Unicast, Multicast (BUM) over the
fabric-enabled core network. This mDNS flooding may impact network performance and security. The
Layer 2 leaf, enabled as SDG agent, prevents mDNS flooding over VXLAN and supports unicast-based
service routing.

• Layer 3 Leaf SDG Agent: The Cisco Catalyst or Cisco Nexus switches can be deployed as SDG agent
supporting Layer 3 overlay network in BGP EVPN VXLAN fabric. The IP gateway and mDNS service
boundary is terminated at the SDG agent switches and remote services can be discovered or distributed
through centralized Cisco DNA Center.

• Local Mode Wireless: The centralized wireless local mode network can be terminated within or outside
the EVPN VXLAN fabric domain to retain network segmentation and service discovery for wireless
endpoints. The Cisco Catalyst 9800 Series Wireless Controller in service peer mode can build unicast
service routing with distribution layer IP and SDG agent Cisco Catalyst switch to discover services from
BGP EVPN VXLAN fabric overlay network.

• Cisco DNA Center: Cisco DNACenter supports Wide Area Bonjour capability to dynamically discover
and distribute mDNS services based on Layer 2 or Layer 3 Virtual Network ID (VNID) policies to route
the mDNS services between SDG agent switches in the network.

For more information about BGP EVPN networks, see Cisco DNA Service for Bonjour Configuration Guide,
Cisco IOS XE Bengaluru 17.6.x (Catalyst 9600 Switches).

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
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C H A P T E R 3
Set up the Cisco Wide Area Bonjour Application

• Overview of the Cisco Wide Area Bonjour Application Installation, on page 15
• Create User Roles, on page 16
• Update the Cisco Wide Area Bonjour Application, on page 16
• Add Devices to the Inventory, on page 17

Overview of the Cisco Wide Area Bonjour Application
Installation

Depending on the installation status of your Cisco DNA Center and Cisco Wide Area Bonjour application,
use one of the following procedures to install the Cisco Wide Area Bonjour application on your Cisco DNA
Center.

Install Cisco Wide Area Bonjour Application on a Fresh Installation of Cisco
DNA Center

For a fresh ISO installation of Cisco DNA Center, follow the instructions outlined in the Cisco DNA Center
Appliance Installation Guide.

After you have installed the Cisco DNA Center appliance, if you have a firewall, allow Cisco DNA Center
to access the following location for all system and package downloads: https://www.ciscoconnectdna.com:443.
To ensure that you have cloud connectivity to AWS, log in to the cluster and run the following CLI command:

maglev catalog settings validate

For more information, see the Cisco DNA Center Appliance Installation Guide.

After you have completed the configuration, connect to AWS, identify and download the Cisco Wide Area
Bonjour application.

To install the Cisco Wide Area Bonjour application in Cisco DNA Center, complete the following steps:

Step 1 Click the menu icon ( ) and choose System > Software Updates.
Step 2 Find Wide Area Bonjour on the list and click Install under the Action column.
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Install the Cisco Wide Area Bonjour Application on a Cisco DNA
High-Availability Cluster

First, set up the Cisco DNA high-availability cluster. For more information, see Cisco DNA Center High
Availability Guide.

After your Cisco DNA Center is set up, complete the following steps to install the Cisco Wide Area Bonjour
application.

Step 1 Click the menu icon ( ) and choose System > Software Updates.
Step 2 Ensure Updates is selected in the left navigation pane.
Step 3 Find Wide Area Bonjour in the Application Updates list and click install under the Action column.

Create User Roles
Cisco DNA Center enables you to create user roles with controlled access. For information about user roles,
see the Cisco DNA Center Administrator Guide.

The minimum required permissions according to user role for the Cisco Wide Area Bonjour application on
Cisco DNA Center are as follows:

Table 4: Required Permissions According to User Role

PermissionAccessUser Role

ReadNetwork Services > BonjourObserver (OBSERVER-ROLE)

WriteNetwork Services > Bonjour• Administrator
(SUPER-ADMIN-ROLE)

• Network Administrator
(NETWORK-ADMIN-ROLE)

If you're a user with an observer role, the options to create or edit data are not enabled in the GUI.Note

Update the Cisco Wide Area Bonjour Application
Cisco periodically releases updates to the Cisco Wide Area Bonjour application. To ensure that you have the
latest version of the Cisco Wide Area Bonjour application installed in your Cisco DNA Center, complete the
following steps:

Step 1 Click the menu icon ( ) and choose System > Software Updates.
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Step 2 Ensure Updates is selected in the left navigation pane.
Step 3 Find Wide Area Bonjour in the Application Updates list and click install under the Action column.

Add Devices to the Inventory
Before you can configure a switch as an SDG agent, you must add it to the Cisco DNA Center Inventory. For
more detailed information about the Inventory, see the Cisco DNA Center User Guide.

Before adding your devices to the Inventory, ensure that the hardware and software versions are supported.
See Supported Platforms, on page 5.

Note

Step 1 Click the menu icon ( ) and choose Provision > Inventory.
Step 2 In the left pane, select the site to which you want to add a device.
Step 3 Click Add Device.

The Add Device dialog box is displayed.

Step 4 From the Type drop-down list, choose Network Device.
Step 5 In the Device IP / DNS Name field, enter the IP address or name of the device.
Step 6 Expand the SNMP area, if it's not already visible.
Step 7 From the Version drop-down list, choose V2C (SNMP Version 2c) or V3 (SNMP, Version 3), and configure the

required fields.
Step 8 Expand the SNMP RETRIES AND TIMEOUT area, if it's not already expanded, and configure the Retries and

Timeout (in seconds) fields.
Step 9 Expand the CLI area, if it's not already expanded, and configure the required fields.
Step 10 Expand the NETCONF area, if it's not already expanded, and configure the Port field.

NETCONF requires that you configure SSH as the CLI protocol and define the SSH credentials.

NETCONF is necessary only for the wireless controller.Note

Step 11 Click Add.
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C H A P T E R 4
Manage the Cisco Wide Area Bonjour
Application

• Cisco Wide Area Bonjour Application Overview, on page 19
• Create Wide Area Bonjour Domain and Policy Structure, on page 22
• Understanding Global Policy Structure, on page 25
• Flexible Wide Area Bonjour Service Routing Design, on page 26
• Cisco Wide Area Bonjour Bulk Configuration, on page 27
• Manage the Cisco Wide Area Bonjour Configuration, on page 32

Cisco Wide Area Bonjour Application Overview
Cisco DNA Center supports rich network controller functions, automation, and assurance capabilities for
enterprise networks. The Cisco Wide Area Bonjour application is an add-on service that enables controller
functions to support mDNS service routing across multiple network deployment models. Cisco DNA Center,
in controller mode, builds stateful service routing peer sessions with network-wide distributed SDG agents.
It dynamically discovers mDNS services and distributes to other SDG agents. IT-defined and global policies
in the Cisco Wide Area Bonjour application define mDNS service routing.

The Cisco Wide Area Bonjour application provides an intuitive GUI to build, manage, and troubleshoot
network-wide service routing peers, global policies, service instances, andmore. As a service routing controller,
the Cisco Wide Area Bonjour application supports policy management to enable service routing and rich
service-assurance capabilities for management and troubleshooting.

The Cisco Wide Area Bonjour application doesn't support network automation to implement service policies
on network devices. You must manually configure service policies on your network.

Note

This chapter provides an overview of the Cisco Wide Area Bonjour application and its supporting functions.

The following figure shows the Cisco Wide Area Bonjour application dashboard.
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Figure 9: Cisco Wide Area Bonjour Application Dashboard

The following table explains the function of the four key areas of the Cisco Wide Area Bonjour application.
For more information about implementing and managing global service routing, see Monitor the Cisco Wide
Area Bonjour Application, on page 87.

Table 5: Cisco Wide Area Bonjour Application Functions

FunctionManage

The Cisco Wide Area Bonjour application dashboard provides a statistical
view of global service routing policies and processing information. The
dashboard is divided into the following categories, each providing unique
service assurance capabilities:

• Dashlets: Key indicators providing configured subdomains and service
filter policy counts, dynamically discovered service instances, and
real-time peering status for Wide Area Bonjour service routing.

• Service Query Statistics: A two-tier historical chart viewwith granular
intervals to monitor average and cumulative mDNS service query
messages from SDG agents, and two-layer charts showing successful
query responses and requests dropped due to mismatched service
policies.

• Top Talkers: Bar charts for top talkers in the network.

Dashboard
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FunctionManage

TheConfiguration tab of the CiscoWide Area Bonjour application enables
you to construct and manage global service routing policies. The
Configuration tab is divided into the following sections:

• Domains and subdomains: The logical structure of enterprise
geolocations associated with SDG agents to enable service routing and
policies in the Wide Area Bonjour domain.

• Service filters: Intuitive two-sided policy constructs enabling global
service discovery and distribution. The mDNS services are accepted
from one or more source SDG agents. The mDNS services are
distributed to one or more query SDG agents.

• 360 degree view: Brief SDG agents, policies, instance count statistics
and status information at multiple subdomain levels for ease of
operation and management.

Configuration

From the Monitor tab of the CiscoWide Area Bonjour application you can
view the detailed status of service routing, service instances, and
troubleshooting information. TheMonitor page is divided into the following
categories:

• SDG agent: The center point to manage, synchronize, and troubleshoot
service routing with network-wide distributed SDG agent switches.
Detailed view of the service filter, device reachability, and device
serviceability for each SDG agent.

• Service instance: A comprehensive view of service instance details
in real-time providing complete reachability source of service,
addressing plan, and service-route state in the Wide Area Bonjour
domain.

• Troubleshooting: The built-in toolkit to troubleshoot the service
routing issues in the Wide Area Bonjour domain. The troubleshooting
logs can be downloaded with selected message-type with brief
information hinting possible challenges for self-resolution.

Monitor

From the Administration tab of the Wide Area Bonjour application, you
can manage advanced service routing parameters. From this tab of the
application, you can manage the following:

• Service type: The key tuple in building global service policies for
WideArea Bonjour service routing. CiscoDNACenter supports built-in
or user-defined custom service type repository mapping of one or more
mDNS poinTeR (PTR) records to user-friendly names.

• Global parameters: Central service routing parameters to build and
manage secure and reliable routing peer connections, such as MD5
authentication, keepalive timers, and inactive service instance
management.

Administration
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Create Wide Area Bonjour Domain and Policy Structure
Before building global service policies in the Wide Area Bonjour, you must first configure foundational
settings. This section focuses on creating the multi-tier logical construct of domains and briefly explains
service policy structures associated with each tier, to implement Wide Area Bonjour service routing policies.

The Wide Area Bonjour application supports the following user-defined domain hierarchy that may align
with the hierarchy of the company's geolocation and building planning:

• Root domain: The Wide Area Bonjour application must have a root domain as the base configuration.
The root domain can be defined as the company's name or major site location, for example. The Wide
Area Bonjour application supports a single root domain.

• Subdomain: The subdomain is a logical construct which you can create, aligning with site location
attributes (such as the building name, for example). TheWide Area Bonjour application supports multiple
subdomains, and you can have further subdomains under a subdomain.

Create Wide Area Bonjour Domains
The root domain configuration is the initial step to configure the Cisco Wide Area Bonjour application.

You can't edit the name of the root domain after it has been configured. To rename a root domain, you must
first delete the domain and then reconfigure it with the new name.

Note

The following figure shows the Configuration tab of the Cisco Wide Area Bonjour application before you
configure a root domain.

Figure 10: Configure a Root Domain in the Cisco Wide Area Bonjour Application

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 In the Domain Name section, enter the name of the root domain.
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Step 3 (Optional) Enter a description for the root domain.
Step 4 Click CREATE.

Create Wide Area Bonjour Subdomain Hierarchies
Configuring a subdomain is a secondary step to configure the Cisco Wide Area Bonjour application based on
your hierarchy configuration requirements. You can extend the subdomain hierarchy to as many levels as
necessary. The Cisco Wide Area Bonjour application provides the flexibility to build the Wide Area Bonjour
service routing global policies at any subdomain level.

The following figure shows the Configuration tab of the Cisco Wide Area Bonjour application.

Figure 11: Cisco Wide Area Bonjour Application - Configuration

TheConfiguration tab is divided into the following subdomain logical panels, supporting ease of configuration
and managing large-scale global policies:

• Subdomain panel: A single-column table which lists configured root domain and subdomains. The
network administrator can briefly collect aggregated counts of downstream subdomains, SDG agents,
and configured service filters for global service-routing in the Wide Area Bonjour domain.

• Subdomain Canvas: A wide canvas which provides the complete domain hierarchical view in a graphical
format. Service filter can be created on a subdomain at any level. The flexible tree structure can be
collapsed to support a condensed view or expanded to enable a 360-degree view of SDG agents, and
service filter counts on a per subdomain level.

You can't edit the name of a subdomain after it has been created. To modify the name of a subdomain, you
must first delete the subdomain and then reconfigure it with the new name.

Note

The following figure shows the steps to be followed to create a subdomain in the Cisco Wide Area Bonjour
application.
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Figure 12: Steps to Create a Subdomain Using the Cisco Wide Area Bonjour Application

Step 1 Navigate to the Configuration tab.
Step 2 From the left pane, select the domain or subdomain under which to create the new subdomain.
Step 3 Click Create Subdomain in the upper-right portion of the GUI.
Step 4 Enter a unique name for the subdomain in the Domain Name field.
Step 5 (Optional) Enter a description for the subdomain.
Step 6 Click CREATE.

Delete Wide Area Bonjour Domain Hierarchies
You can delete the root domain or a subdomin at any point in time. When you delete a domain, the stateful
service-routing adjacencies with SDG agent switches in an associated domain or subdomain are immediately
disconnected. Further, all dynamically discovered mDNS services are flushed away to enforce change
immediately.

You can't undo the deletion of a domain or subdomain. To restore a domain or subdomain, you must manually
reconfigure it or upload a backed up configuration file.

Note

The following figure illustrates the steps required to delete a subdomain.
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Figure 13: Steps to Delete a Subdomain in the Cisco Wide Area Bonjour Application

Step 1 Navigate to the Configuration tab.
Step 2 From the left pane, select the domain or subdomain to be deleted.
Step 3 From the options menu in the upper right portion of the screen, click Delete.
Step 4 Confirm that you want to delete the selected domain or subdomain.

Understanding Global Policy Structure
The global service-policy construct of the Cisco Wide Area Bonjour application uses fundamental concepts
to enable policy-based mDNS service discovery and distribution with stateful and trusted Cisco Catalyst SDG
agent switches. The global service-policy in Wide Area Bonjour is divided into two major categories: source
and query.

You can build service filters in the Cisco Wide Area Bonjour application comprising a set of parameters,
activating one or more mDNS service types to accept services from specific source SDG agent switches and
route services to other SDG agents on-demand from remote receiver end points.

The following figure illustrates a reference global service filter in the Cisco Wide Area Bonjour application.
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Figure 14: Reference Global Service Filter in the Cisco Wide Area Bonjour Application

In the illustration, CiscoWide Area Bonjour accepts mDNS service-type Printer when all configured network
service-routing parameters for the source SDG agent switch match those in the policy. The mDNS service-type
Printer will be routed on-demand to the query SDG agent when all the configured network service-routing
parameters match those from the wireless network location requesting the services.

The CiscoWide Area Bonjour application supports service-routing over multiple types of enterprise networks.

Flexible Wide Area Bonjour Service Routing Design
Enterprise networks need flexibility to discover and dynamically route services across IP networks in various
use cases. The CiscoWide Area Bonjour application supports an intuitive GUI to build service routing policies
for multiple types of routing topologies.

The following figure shows a reference global policy example in the Cisco Wide Area Bonjour application
to enable service routing. You can build unique policies to support one or more mDNS service types to enable
flexible routing across the network.
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Figure 15: Flexible Wide Area Bonjour Service Routing Design

Each service routing policy can be planned and configured in Cisco DNA Center to dynamically discover and
distribute services in the network. The global policy configuration can be easily adjusted to append more
service types, add more SDG agent switches, or include more service peers and networks, as required. To
implement intent-based service routing, you can configure the policy in any deployment model:

• Point-to-point: In this service routing topology, the single source SDG agent switch can be configured
to discover service instances (such as Printer). Cisco DNA Center routes the printer information to a
single remote query SDG agent upon receiving a query request. The global policy may contain advanced
parameters from a selected SDG agent with extended network devices in a service peer role (such as a
Cisco Catalyst 9800 Series Wireless Controller or Catalyst 9000 Switch). This policy configuration type
limits printer from a single source SDG agent to a single query SDG agent, building a point-to-point
routing topology.

• Point-to-multipoint: An expanded version of point-to-point routing topology with more than one query
SDG agent device. This global policy setting provides the ability to route the service from a single source
SDG agent to multiple remote SDG agent network devices upon receiving a query request.

• Multipoint-to-multipoint: An expanded version of point-to-point routing topology with more than one
source SDG agent and query SDG agent. This global policy setting provides the ability to route a service
frommultiple source SDG agents to multiple remote SDG agent network devices upon receiving a query
request.

• Standalone: This service routing topology enables Cisco DNA Center to discover the mDNS service
instances from one or more source SDG agent switches. In this topology, the network administrator does
not have to configure a query SDG agent. This type of configuration allows Cisco DNACenter to discover
and manage SDG agent switches and services, but does not route the service to any SDG agent switches
in the Wide Area Bonjour domain.

Cisco Wide Area Bonjour Bulk Configuration
The Cisco Wide Area Bonjour application gives you the flexibility to build and manage service filter policies
either individually through the GUI or in bulk during any stage of deployment. This section focuses on bulk
provisioning and managing configuration files for backup.
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The service filter policy configuration template is inMicrosoft Excel XLS format. You can download a prebuilt
structured and formatted blank XLS template file from the CiscoWide Area Bonjour application either during
the initial provisioning stage or during runtime from any level of the domain hierarchy, with an up-to-date
configuration. The XLS template file is divided in four sheets, each cross-linked with required details to
automate large-scale service filter policies.

Figure 16: Cisco Wide Area Bonjour Policy Template

The Cisco Wide Area Bonjour XLS template file contains predefined columns and column names that must
remain intact. Changes in the predefined columns and names could result in a failure when importing the
modified file. You must fill in the required data in the respective columns for each sheet based on the following
reference configuration model.

The Selective Services sheet is optional and can be used in advanced service routing scenarios where service
distribution from Cisco DNA Center must be limited to user-defined static MAC addresses. For example, if
Cisco DNA Center discovers up to ten AirPrint-capable printers with Selective Services support, you can
statically assign the MAC addresses of two printers to be shared if a source SDG agent receives a query from
a query SDG agent.

This section provides reference template configuration values to build bulk service filter policy configuration
parameters distributed across multiple worksheets.

The following table lists the parameters to be configured on the Service Type worksheet.

Table 6: Cisco Wide Area Bonjour Policy - Service Type Sheet

DescriptionValueParameter

Enter a user-defined service name
to create a custom service type.

<User-defined service name>Service Type Name

Enter one or more mDNS PTRs.
Each PTR must end with a period
(.) and eachmust be decoupledwith
a comma (,).

<Multicast DNS pointer records>Bonjour Type

You must populate the Domain sheet to build the domain and subdomain hierarchy of the Cisco Wide Area
Bonjour application. As initial configuration, the first entry must be configured with a root domain, followed
by one or more subdomains, listed with the parent domain name as configured for root domain row. The
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hierarchy can be expanded with additional subdomains as necessary, with appropriate parent subdomain
names.

The following table lists the parameters to be configured on the Domain worksheet.

Table 7: Cisco Wide Area Bonjour Policy - Domain Sheet

DescriptionValueParameter

Enter the name of the root domain
or subdomain.

<Root domain or subdomain name>Domain-Name

(Optional) Enter a description for
the domain.

<Domain description>Description

If the domain type in column A is
root domain, leave this cell blank.

If the domain type in column A is
subdomain, enter the name of the
root domain or the subdomain to
build the hierarchy.

<Root domain or subdomain name>Parent-Domain

You must populate the Policy sheet to build global service filter policy in the Cisco Wide Area Bonjour
application. As described in the previous sections, the service filter configuration and management in the
Cisco Wide Area Bonjour application is applied at a subdomain level. Thus, the Policy sheet refers to
information provided in the previous two sheets as a prerequisite and associates new policy configurations to
each domain.

Table 8: Cisco Wide Area Bonjour Policy - Policy Sheet

DescriptionValueParameter

Enter the name of the domain
where this policy needs to be
configured.

<Root domain or subdomain>Domain

Enter one or more mDNS service
types allowed for this policy. Each
service type must be decoupled
with a comma (,) delimiter.

<mDNS Service Type>Service Type

Enter a unique name for the service
policy.

<Policy Name>Policy Name

(Optional) Enter a description for
the service policy.

<Policy Description>Description

Enter True to enable the policy and
False to disable the policy upon
configuration.

<True | False>Enabled
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DescriptionValueParameter

Enter Traditional or Overlay
deployment type. The Overlay
deployment model is supported
with BGP EVPN VXLAN.

<Traditional | Overlay>Deployment Type

Enter the source SDG agent IPv4
address for Cisco DNA Center to
build service routing adjacency and
dynamically learn services.

<Source SDG Agent IPv4 Address>Source IP

Enter Local or Peer depending on
the service layer.

Local: SDG agent switch discovers
mDNS service from directly
attached providers.

Peer: SDG agent switch discovers
mDNS services from downstream
L2 switch or wireless controller
device where providers are
connected.

<Local | Peer>Source Service Layer

Enter the source IPv4 network
address where the service provider
is expected to announce services in
the network.

<Source IPv4 Network Address>Source V4 Network

Enter the source IPv4 network
mask where the service provider is
expected to announce the service
in the network.

<Source IPv4 Network Mask>Source V4 Mask

Enter the source IPv6 network
address where the service provider
is expected to announce the service
in the network.

<Source IPv6 Network Address>Source V6 Network

Enter the source IPv6 network
mask, where the service provider
is expected to announce the service
in the network.

<Source IPv6 Network Mask>Source V6 Mask

If the source Service Layer is Peer,
then enter the source IPv4 address
of the L2 switch or wireless
controller devices, where the
providers are connected.

<Source Peer IPv4 Address>Source Peer ID

Enter the source location group ID.
The valid range is from 0 to 4096.

<Source Location Group ID>Source Location Group ID
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DescriptionValueParameter

If the Deployment Type is Overlay,
then enter the source Layer 3 VNID
or Layer 2 VNIDwhere the service
provider is expected to announce
the service in the BGP EVPN
overlay network.

<Source EVPN Virtual Network
ID>

Source VNI ID

If the Deployment Type is Overlay,
then enter the source SDG agent in
Symmetric IRB (L3 Leaf) or
Asymmetric IRB (L2 Leaf) mode
where the service provider is
expected to announce the service
in the BGPEVPN overlay network.

<Symmetric IRB |Asymmetric IRB>Source IRB

Enter the query SDG agent IPv4
address for Cisco DNA Center to
build service routing adjacency and
dynamically distribute services on
request.

<Query SDG Agent IPv4 Address>Query IP

Enter Local or Peer depending on
the service layer.

Local: The SDG agent switch
expects mDNS receiver endpoints
from directly attached providers.

Peer: The SDG agent switch
expects mDNS receiver endpoints
connected to downstreamL2 switch
or wireless controller devices.

<Local | Peer>Query Service Layer

Enter the query IPv4 network
address, where the endpoint
receiver is expected to request the
service in the network.

<Query IPv4 Network Address>Query V4 Network

Enter the query IPv4 networkmask,
where the endpoint receiver is
expected to request the service in
the network.

<Query IPv4 Network Mask>Query V4 Mask

Enter the query IPv6 network
address where the endpoint receiver
is expected to request the service
in the network.

<Query IPv6 Network Address>Query V6 Network

Enter the query IPv6 network mask
where the endpoint receiver is
expected to request the service in
the network.

<Query IPv6 Network Mask>Query V6 Mask
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DescriptionValueParameter

If the query Service Layer is Peer,
enter the query IPv4 address of L2
switches or wireless controller
devices where the mDNS receiver
endpoints are connected.

<Query Peer IPv4 Address>Query Peer ID

Enter the query location group ID.
The valid range is from 0 to 4096.

<Query Location Group ID>Query Location Group ID

If the Deployment Type is Overlay,
enter the query Layer 3 VNID or
Layer 2 VNID where the mDNS
receiver endpoint is expected to
request the service in the BGP
EVPN overlay network.

<Query EVPN Virtual Network ID>Query VNI ID

If the Deployment Type is Overlay,
enter the query SDG agent in
Symmetric IRB (L3 Leaf) or
Asymmetric IRB (L2 Leaf) mode
where the service provider is
expected to request the service in
the BGP EVPN overlay network.

<Symmetric IRB |Asymmetric IRB>Query IRB

The Advanced Services sheet is an optional sheet, used to configure advanced service distribution to querying
SDG agents. As the network administrator, you can restrict the distribution of service instances based on
matching policy names and the MAC addresses of service provider Bonjour endpoints.

The following table lists the parameters on the Selective Service sheet.

Table 9: Cisco Wide Area Bonjour Policy - Selective Service Sheet

DescriptionValueParameter

Enter the policy name as applied in
the Policy worksheet to enable
selective service instance
distribution instead of all from the
configured network.

<Policy Name>Policy Name

Enter a single MAC address in the
format 00:00:00:00:00:00
associated with the policy. For
another MAC address entry, use
another row.

<Service Provider MAC Address>Source MAC Address

Manage the Cisco Wide Area Bonjour Configuration
The Cisco Wide Area Bonjour application provides flexibility in managing bulk configuration with Import
and Export capabilities. The application domain and policies can be built and imported as initial Day-0
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configuration for bulk provisioning instead of the manual process. The existing policy configuration can be
downloaded to a local computer in an XLS format to either update existing policies or maintain a backup.

The policy configuration import is seamless in operation and can be appended to the CiscoWide Area Bonjour
application while it is operational. The new imported file may include new service-types in a database,
additional services to existing policies, or new subdomains with new policies. During configuration import
the application and service-peering with existing SDG agents remains instact providing non-disruptive bulk
provisioning capabilities to scale up the network and services in the Wide Area Bonjour domain. You can
import your configuration at any level of the domain hierarchy of the application.

The export function downloads a snapshot of the latest configuration from the Cisco Wide Area Bonjour
application to a local computer. The file downloaded from the export function can be used as a configuration
backup which you can later restore, if necessary.

The following figure is a screenshot illustrating the steps to be followed to either import or export the bulk
configuration XLS file.

Figure 17: Steps to Import or Export the Bulk Configuration XLS File

Step 1 Navigate to the Configuration tab.
Step 2 From the left pane, select the domain or subdomain for which you want to import or export the bulk configuration XLS

file.
Step 3 Click the menu button in the upper-right portion of the screen.
Step 4 Click Import to upload your configuration to the Cisco Wide Area Bonjour application from your local computer.

Alternatively, click Export to download the configuration file from the Cisco Wide Area Bonjour application to your
local computer.
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C H A P T E R 5
Deploy Wide Area Bonjour on Traditional
Networks

• About Wide Area Bonjour on Traditional Networks, on page 35
• Traditional LAN and Wireless Local Mode, on page 35
• Traditional LAN and Wireless FlexConnect Local Switching Mode, on page 38
• Traditional LAN and Wireless Embedded Wireless Controller - Catalyst Switch, on page 42
• Traditional LAN and Wireless Embedded Wireless Controller - Catalyst Access Points, on page 45
• Traditional Routed Access LAN and Wireless Local Mode, on page 48
• Traditional Routed Access LAN, on page 52

About Wide Area Bonjour on Traditional Networks
Cisco DNA Service for Bonjour supports various types of traditional wired and wireless LAN network
deployment models. This chapter lists configuration instructions to implement global service filter policies
in the CiscoWide Area Bonjour application, enabling network-wide service-routing functions between various
supporting deployment models.

Traditional LAN and Wireless Local Mode
This section provides guidelines to create a global configuration policy that enablesWide Area Bonjour within
a traditional LAN, providing Bonjour services (such as wired printers) to wireless users connected over
wireless networks with Cisco Wireless Access Points in local mode.

The following figure illustrates example network topologies for traditional LAN and wireless local-mode
networks with Bonjour source and receiver agents across IP networks.
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Figure 18: Traditional LAN and Wireless Local Mode Network Service Routing

The Cisco Catalyst 9800 SeriesWireless Controller with access-point in FlexConnect Central Switching mode
follows the same configuration steps described in this section.

For more information about the Cisco Catalyst 9800 Series Wireless Controller configuration guidelines, see
the Cisco Catalyst 9800 Series Wireless Controller Software Configuration Guide, Cisco IOS XE Amsterdam
17.3.x.

Note

Configure Service Filters for Traditional LAN and Wireless Local Mode
This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted Cisco Catalyst
SDG agent switches across your IP network.

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.

You can also manually edit existing service filters from this list.
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Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Traditional (the default mode).
Step 7 Enter a unique name for the service filter.
Step 8 (Optional) Enter a description for the service filter.
Step 9 Select one or more service types to permit announcements and queries.
Step 10 Enable or disable service filters after creating them. By default, they are enabled.

Configure Source SDG Agents in Traditional LAN and Wireless Local Mode
This section lists additional configuration steps to enable discovering wired printer sources from the LAN
Distribution switches paired with Layer 2 Catalyst Switches in a service peer role. The wireless distribution
switches paired with a Cisco Catalyst 9800 Series Wireless Controller in a service peer role receive query
responses for wired printers and distribute the responses to querying devices over the wireless local mode
network.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, the service can't be distributed across the IP network without configuring a query agent. For the
steps to configure a query SDG agent, see Configure Query SDG Agents in Traditional LAN and Wireless
Local Mode, on page 38.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for Traditional LAN and Wireless Local
Mode, on page 36.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.1) which announces the services (for example,

printer).
Step 4 From the Service Layer drop-down list, choose Peer.
Step 5 Uncheck the Any check box. By default, this check box is unchecked.
Step 6 Select the source VLAN (Vlan-A and Vlan-B) to discover services (printer) from a specific network.
Step 7 Enable or disable a service from a selected IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable a service from a selected IPv6 subnet. By default, this is enabled.
Step 9 Enter the service peer IPv4 address (192.0.2.1). Click the plus icon to add more peers (192.0.2.3). Select Any to accept

services from any peer on the selected VLAN.
Step 10 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 11 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 12 Click DONE.
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Step 13 Click CREATE.

Configure Query SDG Agents in Traditional LAN and Wireless Local Mode
This section lists the additional configuration steps to distribute services to query SDG agents, based on a
policy.

For instructions to configure a source SDG agent, see Configure Source SDG Agents in Traditional LAN and
Wireless Local Mode, on page 37.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for Traditional LAN and Wireless Local
Mode, on page 36.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a query SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.2) that receives queries for the services (printer).
Step 4 From the Service Layer drop-down list, choose Peer.
Step 5 Ensure that the Any check box is unchecked. By default, this is enabled.
Step 6 Select the query VLAN (Vlan-C) to distribute services (printer) to a specific network.
Step 7 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 9 Enter the service peer IPv4 address (192.0.2.2).
Step 10 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 11 Click the plus icon to add more service-peers (192.0.2.4). Select Any to accept services from any peer on a selected
VLAN.

Step 12 (Optional) Click Add Next to add more query agents. (Repeat the preceding steps.)
Step 13 Click DONE.
Step 14 Click CREATE.

Traditional LAN and Wireless FlexConnect Local Switching
Mode

This section provides step-by-step global configuration policy guidelines to enable Wide Area Bonjour over
traditional LAN, which provide Bonjour services (such as wired printers) to local or remotely attached wireless
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users connected over wireless networks with Cisco Wireless Access Points in FlexConnect Local Switching
mode.

The following figure illustrates a reference network topology for traditional LAN and wireless FlexConnect
Local Switching mode networks with Bonjour source and receiver SDG agents across IP networks.

Figure 19: Traditional LAN and Wireless FlexConnect Local Switching Network Service Routing

Cisco Catalyst 9800 Series Wireless Controller with FlexConnect Access Point in Local Switching mode
doesn't require mDNS configuration settings.

For more information about the Cisco Catalyst 9800 Series Wireless Controller configuration guidelines, see
Cisco Catalyst 9800 Series Wireless Controller Software Configuration Guide, Cisco IOS XE Amsterdam
17.3.x.

Note

Configure Service Filters for Traditional LAN and Wireless FlexConnect Local
Switching Mode

This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted Cisco Catalyst
SDG agent switches across your IP network.

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
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Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.

You can also manually edit existing service filters from this list.

Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Traditional (the default mode).
Step 7 Enter a unique name for the service filter.
Step 8 (Optional) Enter a description for the service filter.
Step 9 Select one or more service types to permit announcements and queries.
Step 10 Enable or disable service filters after creating them. By default, they are enabled.

Configure Source SDG Agents in Traditional LAN and Wireless FlexConnect
Local Switching Mode

This section lists the common configuration steps to enable discovering wired printer sources from the LAN
Distribution Block-1 switches paired with Layer 2 Catalyst switches in a service-peer role. The LAN
Distribution Block-2 switches are paired with another pair of Catalyst switches in a service peer role.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, the services can't be distributed across an IP network without configuring a query agent. For steps
to configure a query SDG agent, see Configure Query SDG Agents in Traditional LAN and Wireless
FlexConnect Local Switching Mode, on page 41.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for Traditional LAN and Wireless
FlexConnect Local Switching Mode, on page 39.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.1) that announces the services (Printer).
Step 4 From the Service Layer drop-down list, choose Peer.
Step 5 Uncheck the Any check box. By default, this check box is unchecked.
Step 6 Select the source VLAN (Vlan-A) to discover services (Printer) from a specific network.
Step 7 Enable or disable a service from a selected IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable a service from a selected IPv6 subnet. By default, this is enabled.
Step 9 Enter the service peer IPv4 address (192.0.2.1). Click the plus icon to add more peers (192.0.2.3). Select Any to accept

services from any peer on the selected VLAN.
Step 10 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
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• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 11 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 12 Click DONE.
Step 13 Click CREATE.

Configure Query SDG Agents in Traditional LAN and Wireless FlexConnect
Local Switching Mode

This section lists the additional configuration steps to distribute services to query SDG agents, based on a
policy.

For instructions to configure a source SDG agent, see Configure Source SDG Agents in Traditional LAN and
Wireless FlexConnect Local Switching Mode, on page 40.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for Traditional LAN and Wireless
FlexConnect Local Switching Mode, on page 39.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a query SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.2) that receives queries for the services (printer).
Step 4 From the Service Layer drop-down list, choose Peer.
Step 5 Ensure that the Any check box is unchecked. By default, this is enabled.
Step 6 Select the query VLAN (Vlan-C) to distribute services (printer) to a specific network.
Step 7 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 9 Enter the service peer IPv4 address (192.0.2.2).
Step 10 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 11 Click the plus icon to add more service peers (192.0.2.4). Select Any to accept services from any peer on a selected
VLAN.

Step 12 (Optional) Click Add Next to add more query agents. (Repeat the preceding steps.)
Step 13 Click DONE.
Step 14 Click CREATE.
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Traditional LAN and Wireless Embedded Wireless Controller -
Catalyst Switch

This section provides step-by-step global configuration policy guidelines to enable Cisco Wide Area Bonjour
between Cisco Catalyst 9300 series switches with Embedded Wireless Controller (EWC) function. The
traditional LAN providing Bonjour services, such as wired printers to the local or remote attached wireless
users connected wireless networks with Cisco Wireless Access Points in Local mode.

The following figure illustrates reference network topologies for traditional LAN and wireless Local mode
networks with Bonjour source and receiver across IP networks.

Figure 20: Traditional LAN and EWC on Switch Service Routing

For more information about the Cisco Catalyst 9300 series switch configuration guidelines, see the Software
Configuration Guide, Cisco IOS XE Amsterdam 17.3.x (Catalyst 9300 Switches).

Configure Service Filters for a Traditional LAN and Wireless Embedded
Wireless Controller - Catalyst Switch

This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted Cisco Catalyst
SDG agent switches across your IP network.
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Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.

You can also manually edit existing service filters from this list.

Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Traditional (the default mode).
Step 7 Enter a unique name for the service filter.
Step 8 (Optional) Enter a description for the service filter.
Step 9 Select one or more service types to permit announcements and queries.
Step 10 Enable or disable service filters after creating them. By default, they are enabled.

Configure Source SDG Agents in Traditional LAN and Wireless Embedded
Wireless Controller - Catalyst Switch

This section lists additional configuration steps to enable discovering wired printer sources from the LAN
Distribution Block-1 switches paired with Layer 2 Catalyst Switches in a service-peer role. The LAN
Distribution Block-2 switches are paired with another pair of Catalyst switches in a service peer role.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, it can't be distributed across an IP network without configuring a query agent. For instructions to
configure a query SDG agent, see Configure Query SDG Agents in Traditional LAN andWireless Embedded
Wireless Controller - Catalyst Switch, on page 44.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for a Traditional LAN and Wireless
Embedded Wireless Controller - Catalyst Switch, on page 42.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, this box is unchecked.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.1) that announces the services (printer).
Step 4 From the Service Layer drop-down list, choose Peer.
Step 5 Uncheck the Any check box. By default, this check box is unchecked.
Step 6 Select the source VLAN (Vlan-A) to discover services (printer) from a specific network.
Step 7 Enable or disable a service from a selected source IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable a service from a selected source IPv6 subnet. By default, this is enabled.
Step 9 Enter the service peer IPv4 address (192.0.2.1). Click the plus icon to add more peers (192.0.2.3). Select Any to accept

services from any peer on the selected VLAN.
Step 10 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
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• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 11 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 12 Click DONE.
Step 13 Click CREATE.

Configure Query SDG Agents in Traditional LAN and Wireless Embedded
Wireless Controller - Catalyst Switch

This section lists the additional configuration steps to distribute services to query SDG agents, based on a
policy.

For instructions to configure a source SDG agent, see Configure Source SDG Agents in Traditional LAN and
Wireless Embedded Wireless Controller - Catalyst Switch, on page 43.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for a Traditional LAN and Wireless
Embedded Wireless Controller - Catalyst Switch, on page 42.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a query SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.2) that receives queries for the service type

(printer).
Step 4 From the Service Layer drop-down list, choose Peer.
Step 5 Ensure that the Any check box is unchecked. By default, this check box is unchecked.
Step 6 Select the query VLAN (Vlan-C) to distribute services (printer) to a specific network.
Step 7 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 9 Enter the service peer IPv4 address (192.0.2.2).
Step 10 Click the plus icon to add more service peers (192.0.2.4). Select Any to accept services from any peer on a selected

VLAN.
Step 11 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 12 (Optional) Click Add Next to add more query agents. (Repeat the preceding steps.)
Step 13 Click DONE.
Step 14 Click CREATE.
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What to do next

Create a new reverse service filter configuration to permit Printer service discovery from source 10.0.0.2 and
peer 192.0.2.2, and distribute the service to remote querying SDG agent 10.0.0.1 and wireless users connected
to the peer 192.0.2.3.

Traditional LAN and Wireless Embedded Wireless Controller -
Catalyst Access Points

This section provides step-by-step global configuration policy guidelines to enableWide Area Bonjour between
devices on a traditional LAN network providing Bonjour services (such as wired printers) to local or remotely
connected wired and wireless users. The Bonjour gateway on the Catalyst switch supports controller-less
Wireless networks with Embedded Wireless Controller (EWC) function on the Catalyst Access Points.

The following figure illustrates reference network topologies for traditional LAN and EWC Catalyst Access
Points with Bonjour source and receiver across IP networks.

Figure 21: Traditional LAN and EWC - Catalyst Access Point Network Service Routing

The older access point inMobility Express mode follows the same configuration steps described in this section.Note
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For more information about the Cisco Catalyst Access Point series EWC configuration guidelines, see the
Cisco Embedded Wireless Controller on Cisco Catalyst Access Points.

Configure Service Filters for a Traditional LAN and Wireless Embedded
Wireless Controller - Catalyst Access Points

This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted Cisco Catalyst
SDG agent switches across your IP network.

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.

You can also manually edit existing service filters from this list.

Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Traditional (the default mode).
Step 7 Enter a unique name for the service filter.
Step 8 (Optional) Enter a description for the service filter.
Step 9 Select one or more service types to permit announcements and queries.
Step 10 Enable or disable service filters after creating them. By default, they are enabled.

Configure Source SDG Agents in Traditional LAN and Wireless Embedded
Wireless Controller - Catalyst Access Points

This section provides guidelines for additional configuration steps in global policies to enable discovering
wired printer sources from the LAN distribution switches paired with Layer 2 Cisco Catalyst switches in a
service peer role. The EWC - Catalyst Access Point can receive query responses for local and remote wired
printers when browsed over wireless networks.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, the services can't be distributed across the IP network unless the query agent is configured. For
instructions to configure a query SDG agent, see Configure Query SDG Agents in Traditional LAN and
Wireless Embedded Wireless Controller - Catalyst Access Points, on page 47.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for a Traditional LAN and Wireless
Embedded Wireless Controller - Catalyst Access Points, on page 46.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
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Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.1) that announces the services (printer).
Step 4 From the Service Layer drop-down list, choose Peer.
Step 5 Uncheck the Any check box. By default, this check box is unchecked.
Step 6 Select the source VLAN (Vlan-A) to discover services (printer) from a specific network.
Step 7 Enable or disable a service from a selected IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable a service from a selected IPv6 subnet. By default, this is enabled.
Step 9 Enter the service peer IPv4 address (192.0.2.1).
Step 10 Click the plus icon to add more peers (192.0.2.3). Select Any to accept services from any peer on the selected VLAN.
Step 11 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 12 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 13 Click DONE.
Step 14 Click CREATE.

Configure Query SDG Agents in Traditional LAN and Wireless Embedded
Wireless Controller - Catalyst Access Points

This section lists the additional configuration steps to distribute services to query SDG agents, based on a
policy.

For instructions to configure a source SDG agent, see Configure Source SDG Agents in Traditional LAN and
Wireless Embedded Wireless Controller - Catalyst Access Points, on page 46.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for a Traditional LAN and Wireless
Embedded Wireless Controller - Catalyst Access Points, on page 46.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a query SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.2) that receives queries for the service type

(printer).
Step 4 From the Service Layer drop-down list, choose Peer.
Step 5 Ensure that the Any check box is unchecked. By default, this check box is unchecked.
Step 6 Select the query VLAN (Vlan-C) to distribute services (printer) to a specific network.
Step 7 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 9 Enter the service peer IPv4 address (192.0.2.2).
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Step 10 Click the plus icon to add more service peers (192.0.2.4). Select Any to accept services from any peer on a select
VLAN.

Step 11 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 12 (Optional) Click Add Next to add more query agents. (Repeat the preceding steps.)
Step 13 Click DONE.
Step 14 Click CREATE.

What to do next

Create a new reverse service filter configuration to permit Printer service discovery from source 10.0.0.2 and
peer 192.0.2.2 and enable distribution to remote querying SDG agent 10.0.0.1 and wireless users connected
to peer 192.0.2.3.

Traditional Routed Access LAN and Wireless Local Mode
This section provides step-by-step global configuration policy guidelines to enableWide Area Bonjour between
devices on Routed Access LAN networks, providing Bonjour services (such as wired printers) to remotely
connected wired users and wireless users connected over wireless networks with CiscoWireless Access Points
in Local mode.

The following figure illustrates a reference network topology for Routed Access LAN and wireless Local
mode networks with Bonjour source and receiver devices across IP networks.
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Figure 22: Routed Access LAN and Wireless Local Mode Network Service Routing

Use the configuration steps described in this section for Cisco Catalyst 9800 Series Wireless Controller with
access points in FlexConnect Central Switching mode.

For more information about the Cisco Catalyst 9800 Series Wireless Controller configuration guidelines, see
the Cisco Catalyst 9800 Series Wireless Controller Software Configuration Guide, Cisco IOS XE Amsterdam
17.3.x.

Note

Configure Service Filters for a Traditional Routed Access LAN and Wireless
Local Mode

This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted Cisco Catalyst
SDG agent switches across your IP network.

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.
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You can also manually edit existing service filters from this list.

Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Traditional (the default mode).
Step 7 Enter a unique name for the service filter.
Step 8 (Optional) Enter a description for the service filter.
Step 9 Select one or more service types to permit announcements and queries.
Step 10 Enable or disable service filters after creating them. By default, they are enabled.

Configure Source SDG Agents in Traditional Routed Access LAN and Wireless
Local Mode

This section lists guidelines for additional configuration steps to enable discovering wired printer sources
from LAN switch-1 in an SDG agent role. The wired printer can be discovered by remotely connected wired
users from LAN switch-2, and to wireless users from WLAN Distribution Block-2 switches paired with a
Cisco Catalyst 9800 Series Wireless Controller in a service peer role.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, it can't be distributed across the IP network unless you configure a query SDG agent. For steps to
configure a query SDG agent, see Configure Query SDG Agents for Traditional Routed Access LAN and
Wireless Local Mode, on page 51.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for a Traditional Routed Access LAN and
Wireless Local Mode, on page 49.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.1) that announces the services (printer).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Uncheck the Any check box. By default, this check box is unchecked.
Step 6 Select the source VLAN (Vlan-A) to discover services (Printer) from a specific network.
Step 7 Enable or disable a service from a selected source IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable a service from a selected source IPv6 subnet. By default, this is enabled.
Step 9 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 10 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 11 Click DONE.
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Step 12 Click CREATE.

Configure Query SDG Agents for Traditional Routed Access LAN and Wireless
Local Mode

This section lists the additional configuration steps to distribute services to query SDG agents, based on a
policy.

For instructions to configure a source SDG agent, see Configure Source SDG Agents in Traditional Routed
Access LAN and Wireless Local Mode, on page 50.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for a Traditional Routed Access LAN and
Wireless Local Mode, on page 49.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a query SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.3) that receives queries for the services (printer).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Ensure that the Any check box is unchecked. By default, this is enabled.
Step 6 Select the query VLAN (Vlan-B) to distribute services (printer) to a specific network.
Step 7 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 9 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 10 Click Add Next.
Step 11 From the SDG Agent/IP drop-down list, choose a query SDG agent (10.0.0.2).
Step 12 From the Service Layer drop-down list, choose Peer.
Step 13 Ensure that the Any check box is unchecked. By default, this is enabled.
Step 14 Select the query VLAN (Vlan-C) to distribute services (printer) to a specific network.
Step 15 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 16 Enable or disable services from the selected IPv6 subnet. By default, this is enabled.
Step 17 Enter the service peer IPv4 address (192.0.2.2).
Step 18 Click the plus icon to add more service-peers (192.0.2.4). Select Any to accept services from any peer on a selected

VLAN.
Step 19 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
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• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 20 (Optional) Click Add Next to add more query agents. (Repeat the preceding steps.)
Step 21 Click DONE.
Step 22 Click CREATE.

Traditional Routed Access LAN
This section provides step-by-step global configuration policy guidelines to enableWide Area Bonjour between
devices on Routed Access LAN networks, providing Bonjour services (such as wired printers) to remotely
connected wired users and wireless users.

The following figure illustrates a reference network topology for Routed Access LAN networks with Bonjour
source and receiver devices across IP networks.

Figure 23: Traditional Routed Access LAN Service Routing
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Use the configuration steps described in this section for Cisco Nexus switches.

For more information about the Cisco Nexus switches configuration guidelines, see the Cisco DNA Service
For Bonjour Configuration Guide, Cisco Nexus 9000 Series NX-OS, Release 10.2(3)F.

Note

Configure Service Filters for Traditional Routed Access LAN
This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted SDG agent
switches across your IP network.

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.

You can also manually edit existing service filters from this list.

Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Traditional (the default mode).
Step 7 Enter a unique name for the service filter.
Step 8 (Optional) Enter a description for the service filter.
Step 9 Select one or more service types to permit announcements and queries.
Step 10 Enable or disable service filters after creating them. By default, they are enabled.

Configure Source SDG Agents in Traditional Routed Access LAN
This section lists guidelines for additional configuration steps to enable discovering wired printer sources
from LAN switch-1 in an SDG agent role. The wired printer can be discovered by remotely connected wired
users from LAN switch-2.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, it can't be distributed across the IP network unless you configure a query SDG agent. For steps to
configure a query SDG agent, see Configure Query SDG Agents in Traditional Routed Access LAN, on page
54.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for Traditional Routed Access LAN, on
page 53.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
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Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.1) that announces the services (printer).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Uncheck the Any check box. By default, this check box is unchecked.
Step 6 Select the source VLAN (Vlan-A) to discover services (Printer) from a specific network.
Step 7 Enable or disable a service from a selected source IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable a service from a selected source IPv6 subnet. By default, this is enabled.
Step 9 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 10 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 11 Click DONE.
Step 12 Click CREATE.

Configure Query SDG Agents in Traditional Routed Access LAN
This section lists the additional configuration steps to distribute services to query SDG agents, based on a
policy.

For instructions to configure a source SDG agent, see Configure Source SDG Agents in Traditional Routed
Access LAN, on page 53.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for Traditional Routed Access LAN, on
page 53.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a query SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.3) that receives queries for the services (printer).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Ensure that the Any check box is unchecked. By default, this is enabled.
Step 6 Select the query VLAN (Vlan-B) to distribute services (printer) to a specific network.
Step 7 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 9 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 10 (Optional) Click Add Next to add more query agents. (Repeat the preceding steps.)

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
54

Deploy Wide Area Bonjour on Traditional Networks
Configure Query SDG Agents in Traditional Routed Access LAN



Step 11 Click DONE.
Step 12 Click CREATE.
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C H A P T E R 6
Deploy Wide Area Bonjour on Cisco SD-Access
Networks

• About Wide Area Bonjour on Cisco SD-Access Networks, on page 57
• Cisco SD-Access LAN and Wireless Fabric Mode, on page 57
• Cisco SD-Access with Policy Extended Node LAN and Wireless Local Mode, on page 61
• Cisco SD-Access with Policy Extended Node LAN and Wireless FlexConnect Local Switching Mode,
on page 64

About Wide Area Bonjour on Cisco SD-Access Networks
The Cisco Wide Area Bonjour application supports various types of Cisco SD-Access wired and wireless
LAN network deployment models. This chapter provides step-by-step instructions to implement global service
filter policies in the Cisco Wide Area Bonjour application, enabling network-wide service routing functions
for virtual network environments, without extending the Layer 2 flood boundary.

Cisco SD-Access LAN and Wireless Fabric Mode
This section provides step-by-step global configuration policy guidelines to enableWide Area Bonjour between
Fabric-Edge LAN switches providing Bonjour services, such as wired printers to remotely connected wireless
users connected over Fabric-enabled wireless networks.

The following figure shows a reference network topology for Cisco SD-Access LAN and Fabric mode wireless
networks with Bonjour source and receiver in virtual network environments.
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Figure 24: Cisco SD-Access LAN and Fabric-Enabled Wireless Virtual Network Service Routing

For more information about the Cisco Catalyst 9800 Series Wireless Controller, see the Cisco Catalyst 9800
Series Wireless Controller Software Configuration Guide, Cisco IOS XE Amsterdam 17.3.x.

Create Service Filters for Cisco SD-Access LAN and Wireless Fabric Mode
This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted Cisco Catalyst
SDG agent switches across IP networks.
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Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.

You can also manually edit existing service filters from this list.

Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Traditional (the default mode).
Step 7 Enter a unique name for the service filter.
Step 8 (Optional) Enter a description for the service filter.
Step 9 Select one or more service types to permit announcements and queries.
Step 10 Enable or disable service filters after creating them. By default, the service filters are enabled.

Configure Source SDG Agents in Cisco SD-Access LAN and Wireless Fabric
Mode

This section lists the additional configuration steps to enable discovering wired printer sources from the LAN
Fabric-Edge Switch-1 in an SDG agent role. The wired printer can be discovered by remotely connected
wireless users from the Fabric-Edge LAN Switch-2 in an SDG agent role.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, the services can't be distributed across an IP network unless you configure a query SDG agent. For
steps to configure a query SDG agent, see Configure Query SDG Agents from Cisco SD-Access LAN and
Wireless Fabric Mode, on page 60.

Before you begin

Ensure that you've completed the steps in Create Service Filters for Cisco SD-Access LAN and Wireless
Fabric Mode, on page 58.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.1) that announces the services (printer).
Step 4 If you're using a policy extended node, choose Peer from the Service Layer drop-down list. If you're not using a policy

extended node, choose Local.
Step 5 Uncheck the Any check box. By default, this check box is unchecked.
Step 6 Select the source VLAN (Vlan-A) to discover services (printer) from a specific network.
Step 7 Enable or disable a service from a selected IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable a service from a selected IPv6 subnet. By default, this is enabled.
Step 9 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
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• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 10 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 11 Click DONE.
Step 12 Click CREATE.

Configure Query SDG Agents from Cisco SD-Access LAN and Wireless Fabric
Mode

This section lists the additional configuration steps to distribute services to query SDG agents, based on a
policy.

For instructions to configure a source SDG agent, see Configure Source SDG Agents in Cisco SD-Access
LAN and Wireless Fabric Mode, on page 59.

Before you begin

Ensure that you've completed the steps in Create Service Filters for Cisco SD-Access LAN and Wireless
Fabric Mode, on page 58.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a query SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.3) that receives queries for the services (Printer).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Ensure that the Any check box is unchecked. By default, this is enabled.
Step 6 Select the query VLAN (Vlan-B) to distribute services (printer) to a specific network.
Step 7 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 9 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 10 (Optional) Click Add Next to add more query agents. (Repeat the preceding steps.)
Step 11 Click DONE.
Step 12 Click CREATE.
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Cisco SD-Access with Policy Extended Node LAN and Wireless
Local Mode

This section provides step-by-step global configuration policy guidelines to enableWide Area Bonjour between
the Cisco SD-Access LAN with a policy extended node in Layer 2 access providing Bonjour services (such
as wired printers) to users connected over wireless networks with Cisco wireless access points in local mode.

The following figure illustrates reference network topologies for Cisco SD-Access with Policy Extended Node
LAN and wireless Local mode networks with Bonjour source and receiver devices across the fabric and
external IP networks.

Figure 25: Cisco SD-Access with Policy Extended Node LAN and Wireless Local Mode Network Service Routing

For more information about the Cisco Catalyst 9800 Series Wireless Controller configuration guidelines, see
the Cisco Catalyst 9800 Series Wireless Controller Software Configuration Guide, Cisco IOS XE Amsterdam
17.3.x.

Configure Service Filters for Cisco SD-Access with Policy Extended Node
LAN and Wireless Local Mode

This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted Cisco Catalyst
SDG agent switches across IP networks.
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Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.

You can also manually edit existing service filters from this list.

Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Traditional (the default mode).
Step 7 Enter a unique name for the service filter.
Step 8 (Optional) Enter a description for the service filter.
Step 9 Select one or more service types to permit announcements and queries.
Step 10 Enable or disable service filters after creating them. By default, the service filters are enabled.

Configure Source SDG Agents for Cisco SD-Access with Policy Extended Node
LAN and Wireless Local Mode

This section lists the additional configuration steps to enable discovering wired printer sources from the LAN
Fabric-Edge Switch-1 in an SDG agent role. The wired printer can be discovered by remotely connected
wireless users from the Fabric-Edge LAN Switch-2 in an SDG agent role.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, the services can't be distributed across the IP network unless you configure a query SDG agent. For
steps to configure a query SDG agent, see Configure Query SDG Agents for Cisco SD-Access with Policy
Extended Node LAN and Wireless Local Mode, on page 63.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for Cisco SD-Access with Policy Extended
Node LAN and Wireless Local Mode, on page 61.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.1) that announces the services (printer).
Step 4 From the Service Layer drop-down list, choose Peer.
Step 5 Uncheck the Any check box. By default, this check box is unchecked.
Step 6 Select the source VLAN (Vlan-A) to discover services (printer) from a specific network.
Step 7 Enable or disable a service from a selected IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable a service from a selected IPv6 subnet. By default, this is enabled.
Step 9 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
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• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 10 (Optional) Click the Add Next button to add more source SDG agents. (Repeat the preceding steps.)
Step 11 Click DONE.
Step 12 Click CREATE.

Configure Query SDG Agents for Cisco SD-Access with Policy Extended Node
LAN and Wireless Local Mode

This section lists the additional configuration steps to distribute services to query SDG agents, based on a
policy.

For instructions to configure a source SDG agent, see Configure Source SDG Agents for Cisco SD-Access
with Policy Extended Node LAN and Wireless Local Mode, on page 62.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for Cisco SD-Access with Policy Extended
Node LAN and Wireless Local Mode, on page 61.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.2) that announces the services (printer).
Step 4 From the Service Layer drop-down list, choose Peer.
Step 5 Uncheck the Any check box. By default, this check box is unchecked.
Step 6 Select the source VLAN (Vlan-C) to discover services (printer) from a specific network.
Step 7 Enable or disable a service from a selected IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable a service from a selected IPv6 subnet. By default, this is enabled.
Step 9 Enter the service peer IPv4 address (192.0.2.2).
Step 10 Click the plus icon to add more service peers (192.0.2.4). Check the Any check box to accept services from any peer

on the selected VLAN.
Step 11 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 12 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 13 Click DONE.
Step 14 Click CREATE.
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What to do next

Create a new reverse service filter to permit Printer service discovery from source Fabric-Edge 10.0.0.2 and
peer 192.0.2.2, and distribute the service to remote querying Fabric-Edge SDG agent 10.0.0.1 and wireless
users connected to peer 192.0.2.3.

Cisco SD-Access with Policy Extended Node LAN and Wireless
FlexConnect Local Switching Mode

This section provides step-by-step global configuration policy guidelines to enable Wide Area Bonjour on
Cisco SD-Access with Policy Extended Node LAN providing Bonjour services (such as wired printers) to
local or remote wireless users connected over wireless networks with Cisco wireless access points in
FlexConnect Local Switching mode.

The following figure illustrates reference network topologies for Cisco SD-Access with Policy Extended Node
LAN and wireless FlexConnect Local Switching Mode networks with Bonjour source and receiver in virtual
network environment.

Figure 26: Cisco SD-Access with Policy Extended Node LAN and Wireless FlexConnect Local Switching Network Service Routing
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Configure Service Filters for Cisco SD-Access with Policy Extended Node
LAN and Wireless FlexConnect Local Switching Mode

This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted Cisco Catalyst
SDG agent switches across IP networks.

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.

You can also manually edit existing service filters from this list.

Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Traditional (the default mode).
Step 7 Enter a unique name for the service filter.
Step 8 (Optional) Enter a description for the service filter.
Step 9 Select one or more service types to permit announcements and queries.
Step 10 Enable or disable service filters after creating them. By default, the service filters are enabled.

Configure Source SDG Agents for Cisco SD-Access with Policy Extended Node
LAN and Wireless FlexConnect Local Switching Mode

This section lists the additional configuration steps to enable discovering wired printer sources from the
Fabric-Edge SDG agent LAN Distribution Block-1 switches paired with Layer 2 Catalyst switches in a
service-peer role.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, the services can't be distributed across an IP network unless you configure the query SDG agents.
For steps to configure a query SDG agent, see Create Query SDG Agents for Cisco SD-Access with Policy
Extended Node LAN and Wireless FlexConnect Local Switching Mode, on page 66.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for Cisco SD-Access with Policy Extended
Node LAN and Wireless FlexConnect Local Switching Mode, on page 65.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.1) that announces the services (printer).
Step 4 From the Service Layer drop-down list, choose Peer.
Step 5 Uncheck the Any check box. By default, this check box is unchecked.
Step 6 Select the source VLAN (Vlan-A and Vlan-B) to discover services (printer) from a specific network.

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
65

Deploy Wide Area Bonjour on Cisco SD-Access Networks
Configure Service Filters for Cisco SD-Access with Policy Extended Node LAN and Wireless FlexConnect Local Switching Mode



Step 7 Enable or disable a service from a selected IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable a service from a selected IPv6 subnet. By default, this is enabled.
Step 9 Enter the service peer IPv4 address (192.0.2.1). Click the plus icon to add more peers (192.0.2.3). Select Any to accept

services from any peer on the selected VLAN.
Step 10 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 11 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 12 Click DONE.
Step 13 Click CREATE.

Create Query SDG Agents for Cisco SD-Access with Policy Extended Node
LAN and Wireless FlexConnect Local Switching Mode

This section lists the next configuration steps to distribute services to query SDG agents, based on a policy.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for Cisco SD-Access with Policy Extended
Node LAN and Wireless FlexConnect Local Switching Mode, on page 65.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.2) that announces the services (printer).
Step 4 From the Service Layer drop-down list, choose Peer.
Step 5 Uncheck the Any check box. By default, this check box is unchecked.
Step 6 Select the source VLAN (Vlan-C) to discover services (printer) from a specific network.
Step 7 Enable or disable a service from a selected IPv4 subnet. By default, this is enabled.
Step 8 Enable or disable a service from a selected IPv6 subnet. By default, this is enabled.
Step 9 Enter the service peer IPv4 address (192.0.2.2).
Step 10 Click the plus icon to add more service peers (192.0.2.4). Check the Any check box to accept services from any peer

on the selected VLAN.
Step 11 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 12 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 13 Click DONE.
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Step 14 Click CREATE.

What to do next

Create a new reverse service filter configuration to permit service discovery from the source Fabric-Edge
10.0.0.2 and peer 192.0.2.2, and distribute the service to a remote querying Fabric-Edge SDG agent 10.0.0.1
and wireless users connected to the peer 192.0.2.3.

The Cisco Catalyst 9800 SeriesWireless Controller with FlexConnect Access-Point in Local Switching mode
doesn't require any mDNS configuration settings.

Note
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C H A P T E R 7
Deploy Wide Area Bonjour on BGP EVPN
Networks

• About Wide Area Bonjour on BGP EVPN Networks, on page 69
• BGP EVPN Layer 3 Routed Fabric and Wireless Local Mode, on page 69
• BGP EVPN Distributed AnyCast Gateway Fabric and Wireless Local Mode, on page 73
• BGP EVPN Centralized Gateway Fabric and Wireless Local Mode, on page 76
• BGP EVPN Layer 2 Bridge Fabric and Wireless Local Mode, on page 80
• BGP EVPN Routed Access LAN, on page 83

About Wide Area Bonjour on BGP EVPN Networks
Cisco Wide Area Bonjour supports various types of BGP EVPN overlay networks for wired and traditional
wireless LAN in Local mode network deployment models. This chapter provides step-by-step configuration
to implement global service filter policies in the Cisco Wide Area Bonjour application, which enables
network-wide service routing functions for Layer 3 or Layer 2 overlay virtual network environments, without
extending the Layer 2 flood boundary.

BGP EVPN Layer 3 Routed Fabric and Wireless Local Mode
This section provides step-by-step global configuration policy guidelines to enableWide Area Bonjour between
the BGP EVPN VTEP LAN switch, which provides different Bonjour services such as wired printers, and
remotely connected wired users on different IP subnets and wireless users connected over Local mode wireless
networks.

The following figure illustrates reference network topologies for BGP EVPN Layer 3 routed LAN and Local
mode wireless networks with Bonjour source and receiver devices in virtual network devices.
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Figure 27: BGP EVPN Layer 3 Routed LAN and Local Mode Wireless Virtual Network Service Routing

For more information about the Cisco Catalyst 9800 Series Wireless Controller configuration guidelines, see
the Cisco Catalyst 9800 Series Wireless Controller Software Configuration Guide, Cisco IOS XE Amsterdam
17.3.x.

Configure Service Filters for a BGP EVPN Layer 3 Routed Fabric and Wireless
Local Mode

This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted Cisco Catalyst
SDG agent switches across your IP network.

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.

You can also manually edit existing service filters from this list.

Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Overlay.
Step 7 Enter a unique name for the service filter.
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Step 8 (Optional) Enter a description for the service filter.
Step 9 Choose one or more service types to permit announcements and queries.
Step 10 Enable or disable service filters after creating them. By default, they are enabled.

Configure Source Agents for BGP EVPN Layer 3 Routed Fabric and Wireless
Local Mode

This section provides additional configuration steps to enable discovering wired printer sources from the
EVPNLANVTEP Switch-1 in an SDG agent role. The wired printer can be discovered by remotely connected
wired users in the EVPN LAN VTEP switch-2 in SDG agent role. The wireless distribution switches in a
BGP EVPN VTEP role paired with a Cisco Catalyst 9800 Series Wireless Controller in a service-peer role
receive query responses for wired printers when browsed over wireless Local mode networks.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, the service can't be distributed across the IP network unless you configure the query SDG agent.
For steps to configure a query SDG agent, see Configure Query SDG Agents for BGP EVPN Layer 3 Routed
Fabric and Wireless Local Mode, on page 72.

Before you begin

Ensure you've completed the steps outlined in Configure Service Filters for a BGP EVPN Layer 3 Routed
Fabric and Wireless Local Mode, on page 70.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.1) that announces the services (printer).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Use the toggle switch to enable Symmetric IRB.
Step 6 Uncheck the Any check box. By default, this check box is unchecked.
Step 7 Select the source VLAN (Vlan-A) to discover services (printer) from a specific network.
Step 8 Enable or disable a service from a selected IPv4 subnet. By default, this is enabled.
Step 9 Enable or disable a service from a selected IPv6 subnet. By default, this is enabled.
Step 10 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 11 Enter the L3 VNI ID mapped to the IP VRF. Select Any to accept services from any L3 VNI ID.
Step 12 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 13 Click DONE.
Step 14 Click CREATE.
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Configure Query SDG Agents for BGP EVPN Layer 3 Routed Fabric and Wireless
Local Mode

This section lists the additional configuration steps to distribute service to query SDG agents, based on a
policy.

For instructions to configure a source SDG agent, see Configure Source Agents for BGP EVPN Layer 3
Routed Fabric and Wireless Local Mode, on page 71.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for a BGP EVPN Layer 3 Routed Fabric
and Wireless Local Mode, on page 70.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a query SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.3) that receives queries for the services (printer).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Use the toggle switch to enable Symmetric IRB.
Step 6 Ensure that the Any check box is unchecked. By default, this check box is unchecked.
Step 7 Select the query VLAN (Vlan-B) to distribute services (printer) to a specific network.
Step 8 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 9 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 10 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 11 Enter the L3 VNI ID mapped to the IP VRF. Choose Any to match any L3 VNI ID.
Step 12 From the Service Layer drop-down list, choose Peer.
Step 13 Ensure that the Any check box is unchecked. By default, this check box is unchecked.
Step 14 Select the query VLAN (Vlan-C) to distribute services (printer) to a specific network.
Step 15 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 16 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 17 Enter the service peer IPv4 address (192.0.2.2). Click the plus icon to add more peers. Choose Any to accept services

from any peer on a selected VLAN.
Step 18 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 19 (Optional) Click Add Next to add more query agents. (Repeat the preceding steps.)
Step 20 Click DONE.
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Step 21 Click CREATE.

BGP EVPN Distributed AnyCast Gateway Fabric and Wireless
Local Mode

This section provides step-by-step global configuration policy guidelines to enableWide Area Bonjour between
the BGP EVPN VTEP LAN switch, which provides Bonjour services (such as wired printers) to remotely
connected wired users on the same IP subnet, and wireless users connected over Local mode wireless networks.

The following figure illustrates reference network topologies for BGP EVPN Distributed AnyCast Gateway
LAN and Local mode wireless networks with Bonjour source and receiver devices in the virtual network
environment.

Figure 28: BGP EVPN Distributed AnyCast Gateway LAN and Local Mode Wireless Virtual Network Service Routing

For more information about the Cisco Catalyst 9800 Series Wireless Controller configuration guidelines, see
the Cisco Catalyst 9800 Series Wireless Controller Software Configuration Guide, Cisco IOS XE Amsterdam
17.3.x.
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Configure Service Filters for BGP EVPN Distributed AnyCast Gateway Fabric
and Wireless Local Mode

This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted Cisco Catalyst
SDG agent switches across your IP network.

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.

You can also manually edit existing service filters from this list.

Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Overlay.
Step 7 Enter a unique name for the service filter.
Step 8 (Optional) Enter a description for the service filter.
Step 9 Choose one or more service types to permit announcements and queries.
Step 10 Enable or disable service filters after creating them. By default, they are enabled.

Configure Source SDG Agents for BGP EVPN Distributed AnyCast Gateway
Fabric and Wireless Local Mode

This section provides additional configuration steps to enable discovering wired printer sources from the BGP
EVPNLANVTEP switch-1 in an SDG agent role. The wired printer can be discovered by remotely connected
wired users in EVPN LANVTEP switch-2 in an SDG agent role. The wireless distribution switches in a BGP
EVPN VTEP role, paired with a Cisco Catalyst 9800 Series Wireless Controller in a service peer role, receive
query responses for wired printers when browsed over wireless Local mode networks.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, the services can't be distributed across the IP network unless you configure query SDG agents. For
steps to configure a query SDG agent, see Configure Query SDGAgents for BGP EVPNDistributed AnyCast
Gateway Fabric and Wireless Local Mode, on page 75.

Before you begin

Ensure you've completed the steps outlined in Configure Service Filters for BGP EVPN Distributed AnyCast
Gateway Fabric and Wireless Local Mode, on page 74.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.1) that announces the services (printer).
Step 4 From the Service Layer drop-down list, choose Local.
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Step 5 Use the toggle switch to enable Symmetric IRB.
Step 6 Uncheck the Any check box. By default, this check box is unchecked.
Step 7 Choose the source VLAN (Vlan-A) to discover services (printer) from a specific network.
Step 8 Enable or disable a service from a selected IPv4 subnet. By default, this is enabled.
Step 9 Enable or disable a service from a selected IPv6 subnet. By default, this is enabled.
Step 10 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 11 Enter the L3 VNI ID mapped to the IP VRF. Choose Any to accept services from any L3 VNI ID.
Step 12 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 13 Click DONE.
Step 14 Click CREATE.

Configure Query SDG Agents for BGP EVPN Distributed AnyCast Gateway
Fabric and Wireless Local Mode

This section lists the additional configuration steps to distribute services to query agents, based on a policy.

For instructions to configure a source SDG agent, see Configure Source SDGAgents for BGPEVPNDistributed
AnyCast Gateway Fabric and Wireless Local Mode, on page 74.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for BGP EVPN Distributed AnyCast
Gateway Fabric and Wireless Local Mode, on page 74.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a query SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.3) that receives queries for the services (printer).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Use the toggle switch to enable Symmetric IRB.
Step 6 Ensure that the Any check box is unchecked. By default, this check box is unchecked.
Step 7 Select the query VLAN (Vlan-B) to distribute services (printer) to a specific network.
Step 8 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 9 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 10 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.
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Step 11 Enter the L3 VNI ID mapped to the IP VRF. Choose Any to match any L3 VNI ID.
Step 12 From the Service Layer drop-down list, choose Peer.
Step 13 Ensure that the Any check box is unchecked. By default, this check box is unchecked.
Step 14 Select the query VLAN (Vlan-C) to distribute services (printer) to a specific network.
Step 15 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 16 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 17 Enter the service peer IPv4 address (192.0.2.2). Click the plus icon to add more peers. Choose Any to accept services

from any peer on a selected VLAN.
Step 18 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 19 (Optional) Click Add Next to add more query agents. (Repeat the preceding steps.)
Step 20 Click DONE.
Step 21 Click CREATE.

BGP EVPN Centralized Gateway Fabric and Wireless Local
Mode

This section provides step-by-step global configuration policy guidelines to enableWide Area Bonjour between
the BGP EVPN VTEP LAN switch which provides different Bonjour services (such as wired printers) and
remotely connected wired users on the same Layer 2 overlay VLAN, and wireless users connected over Local
mode wireless networks.

The following figure illustrates reference network topologies for BGP EVPN Centralized Gateway LAN and
Local mode wireless networks with Bonjour source and receiver devices in a virtual network environment.

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
76

Deploy Wide Area Bonjour on BGP EVPN Networks
BGP EVPN Centralized Gateway Fabric and Wireless Local Mode



Figure 29: BGP EVPN Centralized Gateway LAN and Local Mode Wireless Virtual Network Service Routing

For more information about Cisco Catalyst 9800 Series Wireless Controller configuration guidelines, see
Cisco Catalyst 9800 Series Wireless Controller Software Configuration Guide, Cisco IOS XE Amsterdam
17.3.x.

Configure Service Filters for BGP EVPN Centralized Gateway Fabric and
Wireless Local Mode

This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted Cisco Catalyst
SDG agent switches across your IP network.

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.

You can also manually edit existing service filters from this list.

Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Overlay.
Step 7 Enter a unique name for the service filter.
Step 8 (Optional) Enter a description for the service filter.
Step 9 Select one or more service types to permit announcements and queries.
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Step 10 Enable or disable service filters after creating them. By default, they are enabled.

Configure Source SDG Agents in BGP EVPN Centralized Gateway Fabric and
Wireless Local Mode

This section provides additional configuration steps to enable discovering wired printer sources from the
EVPN Layer 2 Leaf LAN VTEP switch-1 in an SDG agent role. The wired printer can be discovered by
remotely connected wired users in the EVPN Layer 2 Leaf LAN VTEP switch-2 in an SDG agent role. The
wireless distribution switches in a BGP EVPN VTEP role, paired with a Cisco Catalyst 9800 Series Wireless
Controller in a service peer role, receive query responses for wired printers when browsed over wireless Local
mode networks.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, the services can't be distributed across the IP network unless you configure query SDG agents. For
steps to configure a query SDG agent, see Configure Query SDGAgents for BGP EVPNCentralized Gateway
Fabric and Wireless Local Mode, on page 78.

Before you begin

Ensure you've completed the steps outlined in Configure Service Filters for BGP EVPN Centralized Gateway
Fabric and Wireless Local Mode, on page 77.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.1) that announces the services (printer).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Use the toggle switch to enable Symmetric IRB.
Step 6 Uncheck the Any check box. By default, this check box is unchecked.
Step 7 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 8 Enter the L2 VNI ID mapped to the IP VRF. Choose Any to accept services from any L2 VNI ID.
Step 9 Click DONE.
Step 10 Click CREATE.

Configure Query SDG Agents for BGP EVPN Centralized Gateway Fabric and
Wireless Local Mode

This section lists the additional configuration steps to distribute service to query SDG agents, based on a
policy.
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For instructions to configure a source SDG agent, see Configure Source SDGAgents in BGPEVPNCentralized
Gateway Fabric and Wireless Local Mode, on page 78.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for BGP EVPN Centralized Gateway
Fabric and Wireless Local Mode, on page 77.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a query SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.3) that receives queries for the services (printer).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Use the toggle switch to enable Symmetric IRB.
Step 6 Ensure that the Any check box is unchecked. By default, this check box is unchecked.
Step 7 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 8 Enter the L2 VNI ID mapped to the MAC VRF. Choose Any to match any L2 VNI ID.
Step 9 Click DONE.
Step 10 Click the radio button to select a query SDG agent. By default, the source radio button is selected.
Step 11 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.2) that receives queries for the services (printer).
Step 12 From the Service Layer drop-down list, choose Peer.
Step 13 Ensure that the Any check box is unchecked. By default, this check box is unchecked.
Step 14 Select the query VLAN (Vlan-C) to distribute services (printer) to a specific network.
Step 15 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 16 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 17 Enter the service peer IPv4 address (192.0.2.2). Choose Any to accept services from any peer on a selected VLAN.
Step 18 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 19 (Optional) Click Add Next to add more query agents. (Repeat the preceding steps.)
Step 20 Click DONE.
Step 21 Click CREATE.
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BGP EVPN Layer 2 Bridge Fabric and Wireless Local Mode
This section provides step-by-step global configuration policy guidelines to enableWide Area Bonjour between
the BGP EVPNVTEP LAN switch providing Bonjour services, such as wired printers, and remotely connected
wired users on the same Layer 2 overlay VLAN and wireless users connected over Local mode wireless
networks.

The following figure illustrates reference network topologies for BGP EVPN Layer 2 LAN and Local mode
wireless networks with Bonjour source and receiver devices in virtual network environments.

Figure 30: BGP EVPN Layer 2 Leaf LAN and Local Mode Wireless Virtual Network Service Routing

For more information about the Cisco Catalyst 9800 Series Wireless Controller configuration guidelines, see
the Cisco Catalyst 9800 Series Wireless Controller Software Configuration Guide, Cisco IOS XE Amsterdam
17.3.x.

Configure Service Filters for BGP EVPN Layer 2 Bridge Fabric and Wireless
Local Mode

This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted Cisco Catalyst
SDG agent switches across your IP network.

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
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Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.

You can also manually edit existing service filters from this list.

Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Overlay.
Step 7 Enter a unique name for the service filter.
Step 8 (Optional) Enter a description for the service filter.
Step 9 Select one or more service types to permit announcements and queries.
Step 10 Enable or disable service filters after creating them. By default, they are enabled.

ConfigureSourceSDGAgentsforBGPEVPNLayer2BridgeFabricandWireless
Local Mode

This section provides additional configuration steps for global policies to enable discovering wired printer
sources from the EVPN Layer 2 Leaf LAN VTEP switch-1 in an SDG agent role. The wireless distribution
switches in a BGP EVPN VTEP role, paired with a Cisco Catalyst 9800 Series Wireless Controller in a
service-peer role, receive query responses for wired printers when browsed over the wireless Local mode
network.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, the services can't be distributed across the IP network unless you configure query SDG agents. For
steps to configure a query SDG agent, see Configure Query SDG Agents for BGP EVPN Layer 2 Bridge
Fabric and Wireless Local Mode, on page 82.

Before you begin

Ensure you've completed the steps outlined in Configure Service Filters for BGP EVPNLayer 2 Bridge Fabric
and Wireless Local Mode, on page 80.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.1) that announces the services (printer).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Use the toggle switch to enable Symmetric IRB.
Step 6 Uncheck the Any check box. By default, this check box is unchecked.
Step 7 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 8 Enter the L2 VNI ID mapped to the IP VRF. Choose Any to accept services from any L2 VNI ID.
Step 9 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 10 Click DONE.
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Step 11 Click CREATE.

Configure Query SDG Agents for BGP EVPN Layer 2 Bridge Fabric and Wireless
Local Mode

This section lists the additional configuration steps to distribute service to query SDG agents, based on a
policy.

For instructions to configure a source SDG agent, see Configure Source SDG Agents for BGP EVPN Layer
2 Bridge Fabric and Wireless Local Mode, on page 81.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for BGP EVPN Layer 2 Bridge Fabric
and Wireless Local Mode, on page 80.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a query SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.3) that receives queries for the services (printer,

for example).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Use the toggle switch to enable Symmetric IRB.
Step 6 Ensure that the Any check box is unchecked. By default, this check box is unchecked.
Step 7 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 8 Enter the L2 VNI ID mapped to the MAC VRF. Choose Any to match any L2 VNI ID.
Step 9 Click Done.
Step 10 From the SDG Agent/IP drop-down list, choose an SDG agent (10.0.0.2) that receives queries for the service type

(printer).
Step 11 From the Service Layer drop-down list, choose Peer.
Step 12 Ensure that the Any check box is unchecked. By default, this check box is unchecked.
Step 13 Select the query VLAN (Vlan-C) to distribute services (printer) to a specific network.
Step 14 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 15 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 16 Enter the service peer IPv4 address (192.0.2.2). Click the plus icon to add more peers. Choose Any to accept services

from any peer on a selected VLAN.
Step 17 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
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• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 18 (Optional) Click Add Next to add more query agents. (Repeat the preceding steps.)
Step 19 Click DONE.
Step 20 Click CREATE.

BGP EVPN Routed Access LAN
This section provides step-by-step global configuration policy guidelines to enableWide Area Bonjour between
the BGP EVPN VTEP LAN switch, which provides different Bonjour services such as wired printers, and
remotely connected wired users and wireless users on different IP subnets.

The following figure illustrates reference network topology for BGP EVPN routed access LAN with Bonjour
source and receiver devices in virtual network devices.

Figure 31: BGP EVPN Routed Access LAN Service Routing
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For more information about the Cisco Nexus switches configuration guidelines, see the Cisco DNA Service
For Bonjour Configuration Guide, Cisco Nexus 9000 Series NX-OS, Release 10.2(3)F.

Configure Service Filters for BGP EVPN Routed Access LAN
This section lists the general steps to implement global service filters, which permit the Cisco Wide Area
Bonjour application to dynamically discover and distribute service information between trusted SDG agent
switches across your IP network.

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain for which you want to create the service filter.
Step 3 Ensure that the Service Filter box is checked.
Step 4 Click the service filter icon from the topology to view a list of the service filters for the selected domain.

You can also manually edit existing service filters from this list.

Step 5 Click Create Service Filter.
Step 6 From the Network Mode drop-down list, choose Overlay.
Step 7 Enter a unique name for the service filter.
Step 8 (Optional) Enter a description for the service filter.
Step 9 Choose one or more service types to permit announcements and queries.
Step 10 Enable or disable service filters after creating them. By default, they are enabled.

Configure Source SDG Agents for BGP EVPN Routed Access LAN
This section provides additional configuration steps to enable discovering wired printer sources from the
EVPNLANVTEP Switch-1 in an SDG agent role. The wired printer can be discovered by remotely connected
wired users in the EVPN LAN VTEP switch-2 in SDG agent role.

A unidirectional service filter allows network-wide service discovery for operation and management purposes.
However, the service can't be distributed across the IP network unless you configure the query SDG agent.
For steps to configure a query SDG agent, see Configure Query SDG Agents in Traditional Routed Access
LAN, on page 54.

Before you begin

Ensure you've completed the steps outlined in Configure Service Filters for BGP EVPN Routed Access LAN,
on page 84.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a source SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.1) that announces the services (printer).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Use the toggle switch to enable Symmetric IRB.
Step 6 Uncheck the Any check box. By default, this check box is unchecked.
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Step 7 Select the source VLAN (Vlan-A) to discover services (printer) from a specific network.
Step 8 Enable or disable a service from a selected IPv4 subnet. By default, this is enabled.
Step 9 Enable or disable a service from a selected IPv6 subnet. By default, this is enabled.
Step 10 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 11 Enter the VNI ID mapped to the IP VRF. Select Any to accept services from any VNI ID.
Step 12 (Optional) Click Add Next to add more source SDG agents. (Repeat the preceding steps.)
Step 13 Click DONE.
Step 14 Click CREATE.

Configure Query SDG Agents for BGP EVPN Routed Access LAN
This section lists the additional configuration steps to distribute service to query SDG agents, based on a
policy.

For instructions to configure a source SDG agent, see Configure Source SDG Agents for BGP EVPN Routed
Access LAN, on page 84.

Before you begin

Ensure that you've completed the steps in Configure Service Filters for BGP EVPN Routed Access LAN, on
page 84.

Step 1 Click Add in the upper-right corner of the window.
Step 2 Click the radio button to select a query SDG agent. By default, the source radio button is selected.
Step 3 From the SDG Agent/IP drop-down list, choose an SDG agent (192.0.2.3) that receives queries for the services (printer).
Step 4 From the Service Layer drop-down list, choose Local.
Step 5 Use the toggle switch to enable Symmetric IRB.
Step 6 Ensure that the Any check box is unchecked. By default, this check box is unchecked.
Step 7 Select the query VLAN (Vlan-B) to distribute services (printer) to a specific network.
Step 8 Enable or disable services from the selected query IPv4 subnet. By default, this is enabled.
Step 9 Enable or disable services from the selected query IPv6 subnet. By default, this is enabled.
Step 10 For Location Group, do one of the following:

• To accept services from any location group, check the check box.
• To accept services from location group 0, choose Default from the drop-down list.
• To use a custom location group ID, choose Custom from the drop-down list and enter the location group ID. The
valid range is from 1 to 4096.

Step 11 Enter the VNI ID mapped to the IP VRF. Choose Any to match any VNI ID.
Step 12 (Optional) Click Add Next to add more query agents. (Repeat the preceding steps.)
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Step 13 Click DONE.
Step 14 Click CREATE.
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C H A P T E R 8
Monitor the Cisco Wide Area Bonjour
Application

• Cisco Wide Area Bonjour Application Assurance, on page 87
• Cisco Wide Area Bonjour Assurance Overview, on page 87
• Cisco Wide Area Bonjour Application Dashboard, on page 88
• Subdomain 360°, on page 90
• Wide Area Bonjour Monitor, on page 93

Cisco Wide Area Bonjour Application Assurance
The CiscoWide Area Bonjour application supports comprehensive assurance capabilities. It manages service
routing with network-wide, distributed Cisco Catalyst and Cisco Nexus switches in SDG agent roles, and
mDNS services discovered over the Wide Area Bonjour domain. You can determine the service routing state,
mDNS service state, and more at various levels for day-2 operations, analysis, and troubleshooting. This
chapter provides guidelines to manage the Cisco Wide Area Bonjour application with various supporting
service routing assurance functions.

Cisco Wide Area Bonjour Assurance Overview
The CiscoWide Area Bonjour application supports multilevel assurance capabilities for day-to-day operations.
The service routing, instance monitoring, management, and troubleshooting functions are divided into three
major categories. Each category serves a unique function to manage and troubleshoot Wide Area Bonjour
service routing for day-2 operation. The Monitor function comprises the following categories:

• Dashboard: The Cisco Wide Area Bonjour application landing page provides key statistics in various
formats to quickly determine service routing health across the network. Network administrators can
monitor the operational status of service routing with SDG agent devices, historical charts of service
discovery requests, processing and drops from network-wide distributed devices, and the top-five talkers
across the network.

• Subdomain 360°: Network administrators can collect statistics and status counts in the 360° view.When
you click a subdomain, the left-panel monitoring and configuration bar opens automatically. You can
verify configured policies and discovered service instances on a per-subdomain basis in the Configuration
section.
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• Monitor: You can use the comprehensive three-tier monitoring and troubleshooting function for various
day-2 operations. Network administrators use the detail view of the SDG agent, service instance, and
advanced troubleshooting capabilities to manage and troubleshoot the Wide Area Bonjour domain with
a single pane of glass in Cisco DNA Center.

Cisco Wide Area Bonjour Application Dashboard
The Cisco Wide Area Bonjour dashboard provides real-time, aggregated information about service counts,
and state visibility combined with top talkers across the Wide Area Bonjour domain. The Cisco Wide Area
Bonjour application home page is divided into three layouts that provide key indicators of the overall health
of the Wide Area Bonjour domain. These domains show the SDG agent device reachability, service routing
status, and query statistics in real time.

The following figure shows the Cisco Wide Area Bonjour application dashboard.

Figure 32: Cisco Wide Area Bonjour Application Dashboard

Top talkers3Dashlets1

Service query2

The following table describes the Cisco Wide Area Bonjour application dashboard functions.
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Table 10: Cisco Wide Area Bonjour Application Dashboard Functions

FunctionManagement

Dashlets provide a quick statistical view of policy configuration and global service
routing status. Dashlets are divided into the following categories, which provide unique
service assurance capabilities:

• Subdomain: Total count of configured subdomains in the Cisco Wide Area
Bonjour application. A subdomain is a logical grouping of network devices,
policies, and mDNS services that can be represented in an enterprise network
location, such as Bldg-1.

• Service Filter: Total count of service filter policies configured across all
subdomains of the CiscoWide Area Bonjour application. The service filter count
includes active and inactive policies.

• Service Instance: Total dynamically discovered service instance count from all
SDG agent switches across the Wide Area Bonjour domain. The service instance
count includes active and inactive entries.

• SDG Agent: Provides assurance information:

• Total number of SDG agent switches in UP state with service routing in
operational state.

• Total number of SDG agent switches in DOWN state with service routing
in nonoperational state.

• Total number of SDG agent switches in REACHABLE state with operational
IP connectivity.

• Total number of SDG agent switches in UNREACHABLE state with
nonoperational IP connectivity.

Dashlets

Provides a historical chart view of the average number of mDNS service querymessages
that the Cisco DNACenter received from each SDG agent. The SDG agent sends these
messages to discover services for locally attached wired or wireless endpoints. You
can adjust the chart based on the date, time range, and minute interval providing deeper
andmore granular statistics counters within the provided time series. Two-layer average
service query charts provide the following statistics:

• Processed: The Cisco Wide Area Bonjour classify and mark Processed for a
complete flow of incoming service discovery request is successfully matched
with policy permission and outgoing service distribution to each querying SDG
agent.

• Dropped: The CiscoWide Area Bonjour classify andmark Dropped for incoming
service discovery request and policy permission has a mismatch from each
querying SDG agent.

Service Query –
Average Statistics
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FunctionManagement

Provides a historical chart view of the total or cumulative number of mDNS service
query messages that the Cisco DNA Center received from all SDG agents. The SDG
agents send these messages to discover services for locally attached wired or wireless
endpoints. The chart can be adjusted based on the date, time range, and minute interval
providing deeper and more granular cumulative statistics counters within the provided
time series. Two-layer average service query charts provide the following statistics:

• Processed: Aggregated statistics for the Cisco Wide Area Bonjour classify and
mark Processing for a complete flow of incoming service discovery request is
successfully matched with policy permission and outgoing service distribution
to all querying SDG agents.

• Dropped: Aggregated statistics for the Cisco Wide Area Bonjour classify and
mark Dropped for incoming service discovery request and policy permission has
a mismatch from all querying SDG agents.

Service Query –
Cumulative
Statistics

A bar chart for top talkers across theWide Area Bonjour domain. The top-talker charts
are divided into the following categories to determine overall service scale count by
instance, location, and type:

• Top Subdomain: The top-five subdomains in the Wide Area Bonjour domain
advertising the highest mDNS service instance count. The total service instance
count is an aggregated value that may source from one or more SDG agent
switches.

• Top SDG Agent: The top-five SDG agent switches in the Wide Area Bonjour
domain advertising the highest mDNS service instance count. The total service
instance count is an aggregated value that may source from one or more
downstream service peer devices.

• Top Service Instance: The top-fivemDNS service types in theWideArea Bonjour
domain with the highest service instance count. The total service instance count
by service typemay source throughmultiple subdomains, SDG agents, and service
peer devices in the network.

Top Talkers

Subdomain 360°
Network administrators can get a 360° statistics view of the subdomain and associated parameters from the
Configuration tab. The 360° statistics provide information at the individual subdomain level instead of
global-level visualization on the dashboard. The Subdomain 360° view lets you navigate the different levels
of the hierarchical domain structure and verify the aggregated statistics for policy configuration, service
instance count, and more.

The Subdomain 360° view can be grouped into two-level parameters for service filter policy and SDG agent
of the selected subdomain.

The following figure shows the Subdomain 360° view for Service Filter statistics.
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Figure 33: Subdomain 360° View for Service Filter

To open the Subdomain 360° view for service filter, complete the following steps.

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain.
Step 3 Check the Service Filter check box to expand the hierarchy and verify the aggregated service filter counts for the selected

subdomain.
Step 4 Click the Service Filter icon to open the 360° panel and create a new service filter or verify information about an existing

service filter, described as follows.
FunctionManagement

Displays the user-defined service filter name of the selected subdomain.Filter Name

Displays a collapsed list of one or more permitted service types in the configured service
filter. Click again to verify the expanded list.

Service Type(s)

Displays the aggregated service instance count permitted by the selected service filter.Instances

Displays the status of the selected service filter.State

• Green: The service filter is active and can perform service routing in the Wide Area
Bonjour domain.

• Red: The service filter is inactive and disabled by the network administrator for
service routing in the Wide Area Bonjour domain.

Click the pencil icon to update an existing service filter. To delete a service filter, click
the trash icon.

Action

Check the check box to filter the service filter list by Active state. The default state is
checked.

Active

Check the check box to filter the service filter list by Inactive state. The default state is
checked.

Inactive
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FunctionManagement

Search for a service filter by exact name or initial characters.Search

Displays the service filter count per page. The range is from 15 to 75; the default is 15.Items per Page

Subdomain 360° View of an SDG Agent
The following figure shows the Subdomain 360° view for SDG agent statistics.

Figure 34: Subdomain 360° View for SDG Agent

To open the Subdomain 360° view for an SDG agent, complete the following steps.

Step 1 Navigate to the Configuration tab in the Cisco Wide Area Bonjour application.
Step 2 From the sidebar, select the subdomain.
Step 3 Check the SDG Agent check box to expand the hierarchy and verify the aggregated SDG agent counts for the selected

subdomain.
Step 4 Click the SDG Agent icon to open the 360° panel and verify aggregated statistics and status for an existing SDG agent,

described as follows.
FunctionManagement

Displays the IPv4 address paired with Cisco Wide Area Bonjour for service routing with
the SDG agent switch on the selected subdomain.

SDG Agent IP

Displays the aggregated service instance count learned from the SDG agent configured in
the source role.

Instances

Displays the service routing status between Cisco DNACenter and the SDG agent switches.State

• Green: The SDG agent is reachable and service routing is in operational state to
advertise and query mDNS services in the Wide Area Bonjour domain.

• Red: The SDG agent is reachable or unreachable and service routing is nonoperational.
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FunctionManagement

Check the check box to filter the SDG agent list by Active state. The default state is checked.Active

Check the check box to filter the SDG agent list by Inactive state. The default state is
checked.

Inactive

Enter the SDG agent IPv4 address to search by address or initial numerical value for multiple
matching digits.

Search

Displays the SDG agent count per page. The range is from 15 to 75; the default is 15.Items per Page

Wide Area Bonjour Monitor
The CiscoWide Area Bonjour application provides detailed assurance capabilities for day-2 operations under
the Monitor tab. The Monitor section is divided into three major categories. Each category provides unique
information to manage service routing and instances from a single pane of glass in Cisco DNA Center.

Monitor an SDG Agent
The Monitor > SDG Agents function provides a list of network devices associated to service policies of the
CiscoWide Area Bonjour application. The detailed view shows the communication path, role, state, and more.
Network administrators can quickly determine the operational state andmanually synchronize service instances
from the selected source SDG agent.

The following figure shows how to monitor each associated SDG agent with the Cisco Wide Area Bonjour
application for global service routing.

Figure 35: Monitor SDG Agents

Network administrators canmonitor andmanage the status of each associated SDG agent switch in the network,
described as follows.
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Table 11: Monitor SDG Agent Functions

FunctionManagement

The SDG agent IPv4 address paired with Cisco DNA Center for service
routing in the Cisco Wide Area Bonjour application.

SDG Agent IP

The IPv4 address of the SDG agent switch paired with the Cisco DNA
Center network inventory for device management.

Management IP

The source interface ID (such as Loopback) used on the selected SDG agent
for service routing with the Cisco Wide Area Bonjour application.

Source Interface

The subdomain name where the selected SDG agent is associated to support
service routing.

Domain

The collapsed view of one or more service filters associated with the selected
SDG agent switch. Click more to view the full list.

Service Filter(s)

The SDG agent role can be verified as Source or Query across multiple
service filters:

• Source: The selected SDG agent is expected to connect service
providers (such as Apple TV) and announce mDNS service instances
to the Cisco Wide Area Bonjour application.

• Query: The selected SDG agent is expected to connect service queriers
(such as Apple iPad) and query mDNS service instances to the Cisco
Wide Area Bonjour application.

Role(s)

The total dynamically received service instance count from the selected
source SDG agent switch. The total count includes service instances in
Active and Inactive states in the Cisco Wide Area Bonjour application.

Available Services

The IP reachability between Cisco DNACenter and the selected SDG agent
switch.

• Green: The selected SDG agent is reachable and in managed state in
the Cisco DNA Center device inventory.

• Red: The selected SDG agent is unreachable or failed to reachmanaged
state in the Cisco DNA Center device inventory.

Reachability

The service routing status between Cisco DNA Center and the SDG agent
switches.

• Green: The SDG agent is reachable and service routing is in operational
state to advertise and query mDNS services in the Wide Area Bonjour
domain.

• Red: The SDG agent is reachable or unreachable and service routing
is nonoperational.

State
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FunctionManagement

The last date and time when Cisco Wide Area Bonjour automatically or
manually synchronized the mDNS service instance with one or more source
SDG agent switches.

Last Sync

The Cisco Wide Area Bonjour application lets network administrators
manually synchronize the mDNS service instance with one or more selected
source SDG agent switches.

1. Check the check box in the first column to select one or more SDG
agents in the source role.

2. Click the Resync button on the top-right side of the SDG agent table.

Resync

The mDNS service instance resynchronization status between the Cisco
Wide Area Bonjour application and the source SDG agent switches in the
network:

• Successful: Complete mDNS service instance and respective
information is fully synchronized between the Cisco Wide Area
Bonjour application and the selected source SDG agent switches in
the network.

• In Progress: mDNS service instance synchronization is in progress
between the Cisco Wide Area Bonjour application and the selected
source SDG agent switches in the network.

• Failed: CiscoWide Area Bonjour failed to complete resynchronization
of service instance information within the allotted time with one or
more source SDG agent switches.

• Not Initiated: Service routing with the source SDG agent is in
nonoperational state, or the SDG agent is in a query role and service
instance record resynchronization is not required.

Resync Status

Check the check box to filter the SDG agent list by Active state. The default
state is checked.

Active

Check the check box to filter the SDG agent list by Inactive state. The
default state is checked.

Inactive

The SDG agent count per page. The range is from 15 to 75; the default is
15.

Items per Page

SDG Agent Filter
In large-scale enterprise network environments, network administrators can filter the SDG agent list with
variable parameters. The following figure shows the SDG agent filter.
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Figure 36: SDG Agent Filter

Step 1 Navigate to the Monitor tab in the Cisco Wide Area Bonjour application.
Step 2 Expand the drop-down menu and choose SDG Agent.
Step 3 Above the SDG agent table, click Filter.
Step 4 Choose filter criteria as described in the following table.

FunctionManagement

Choose Single,Multiple, orAll to filter source SDG agents
by current resynchronization status.

Resync Status

The source SDG agent IPv4 address used for service routing
with the Cisco Wide Area Bonjour application.

SDG Agent

The subdomain name where the SDG agents are associated
to support service routing.

Domain(s)

The service filter namewhere the SDG agents are associated
to support service routing.

Service Filter(s)

Choose Source, Query, or All to filter SDG agents by
configured role.

Role(s)

Step 5 Click Apply.

Monitor Service Instance
Cisco DNACenter dynamically discovers network-wide service instances via service routing communication
with source SDG agent switches. The Service Instancewindow provides detailed information of each instance
and its respective address, location and routing state in the Wide Area Bonjour domain.

The following figure shows how to monitor dynamically discovered mDNS service instances from source
SDG agent with Cisco Wide Area Bonjour application for global service routing.
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Figure 37: Monitor Service Instance

Network administrators can monitor and manage the status of each associated service instance in the network,
as shown in the following table.

Table 12: Monitor Service Instance Functions

FunctionManagement

The mDNS service provider-announced instance name across the Wide
Area Bonjour domain, such as FL1-Printer.

Name

The network administrator-appended text to the original announced mDNS
instance name. For example, the Zone1 suffix is added to the original
instance name FL1-Printer and becomes FL1-Printer-Zone1.

Instance Suffix

The source subdomain name where the service instance is discovered
dynamically.

Domain(s)

The name of the service filter in which the policy is validated, and the service
instance accepted from a valid source SDG agent switch.

Service Filter(s)

The IP address of the source SDG agent switch of the selected service
instance.

SDG Agent IP

The collapsed view of service types for the selected service instance. Click
more to view the full list.

Service Type(s)

The IPv4 address of the first-hop Catalyst switch or wireless controller in
the service peer role that is directly attached to the service provider. This
peer announces themDNS service in theWideArea Bonjour domain through
the intermediate source SDG agent switch. The entry is empty if the service
instance learned from the service provider is attached to the SDG agent, or
if the SDG agent is connected to an intermediate Layer 2 mDNS flood
device to reach the service provider.

Peer ID

The location group ID of the service instance.Location Group ID

The mDNS service instance sourced from the BGP EVPN Layer 2 or Layer
3 virtual network ID (VNI) from the SDG agent in overlay VXLAN tunnel
endpoint (VTEP) or border network roles.

VNI ID
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FunctionManagement

The mDNS service instance discovered from the source SDG agent from a
specific unicast-mode Layer 2 VLAN ID. The service instance discovered
from mDNS flood mode is empty.

VLAN ID

The Time-to-Live (TTL) value of mDNS service instance records announced
by source SDG agent switches in the Wide Area Bonjour domain.

TTL

The IPv4 address announced in the mDNS A record by the selected source
mDNS service instance.

Instance IPv4

The IPv6 address announced in the mDNS AAAA record by the selected
source mDNS service instance.

Instance IPv6

The MAC address of the source mDNS service provider discovered and
announced by the source SDG agent.

MAC Address

The mDNS service instance maintains the following routing states in the
Cisco Wide Area Bonjour application:

• Active: The selected mDNS service instance is available with original
source information and distributed when queried in the Wide Area
Bonjour domain.

• Inactive: The selected mDNS service instance is unavailable from the
original source information and is not distributed when queried in the
Wide Area Bonjour domain.

State

Check the check box to filter the service instance list by Active state. The
default state is checked.

Active

Check the check box to filter the service instance list by Inactive state. The
default state is checked.

Inactive

The service instance count per page. The range is from 15 to 75; the default
is 15.

Items per Page

Service Instance Filter
In large-scale enterprise network environments, you can filter the service instance list with variable parameters.
The following figure shows the service instance filter.
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Figure 38: Service Instance Filter

Step 1 Navigate to the Monitor tab in the Cisco Wide Area Bonjour application.
Step 2 Expand the drop-down list and choose Service Instance.
Step 3 Above the service instance table, click Filter.
Step 4 Choose one of following the filter criteria.

FunctionManagement

Search by the exact service filter name or search by initial
characters.

Name

Search by the exact instance suffix name or search by initial
characters.

Instance Suffix

Search by the exact subdomain name or search by initial
characters.

Domain(s)

Search by the exact service filter name or search by initial
characters.

Service Filter(s)

Enter the SDG Agent IPv4 address to search by address, or
enter initial numerical values for multiple matching digits.

SDG Agent IP

Search by the exact service type or search by initial
characters.

Service Type(s)

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
99

Monitor the Cisco Wide Area Bonjour Application
Service Instance Filter



FunctionManagement

Enter the source service peer switch or wireless controller
IPv4 address to search by address, or enter initial numerical
values for multiple matching digits.

Peer ID

Enter the source BGP EVPN Layer 2 or Layer 3 VNI ID to
search by ID, or enter initial numerical values for multiple
matching digits. The range is from 4096 to 16777215.

VNI ID

Enter the unicast mode source Layer 2 VLAN ID to search
by ID, or enter initial numerical values for multiple
matching digits. The range is from 1 to 4094.

VLAN ID

Enter the source service instance IPv4 address to search by
address, or enter initial numerical values for multiple
matching digits.

Instance IPv4

Enter the source service instance IPv6 address to search by
address, or enter initial numerical values for multiple
matching digits.

Instance IPv6

Enter the source service instance MAC address name to
search by MAC address, or enter initial numerical values

MAC Address

for multiple matching digits. The supported format is
00:00:00:00:00.

Step 5 Click Apply.

Troubleshoot the Cisco Wide Area Bonjour Application
The Cisco Wide Area Bonjour application supports built-in troubleshooting capabilities that allow network
administrators to debug service routing, discovery, and distribution problems in the network. You can collect
troubleshooting logs from the Cisco DNA Center back end at various levels based on a date and time range.
Troubleshooting reports are generated in simple CSV format and downloaded locally to review problems
based on selected logging level parameters.

Troubleshooting reports are also useful to share with Cisco support. The following figure shows the
Troubleshoot window of the Cisco Wide Area Bonjour application.
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Figure 39: Cisco Wide Area Bonjour Application Troubleshoot Window

Step 1 Navigate to the Monitor tab in the Cisco Wide Area Bonjour application.
Step 2 From the drop-down menu, choose Troubleshoot.
Step 3 Choose the From and To dates to download log files for a specific date range to your local computer.
Step 4 Choose advanced filter criteria as described in the following table, then click Download.

DescriptionAdvanced Filter Type

Choose Announcement when the SDG agent-announced
services cannot be found on Cisco DNA Center.

Announcement

Choose Query when wired or wireless users cannot see
remote services from Cisco DNA Center.

Query

Choose Hello when the service routing peering session
between Cisco DNA Center and the SDG agent is unstable
or cannot be established.

Hello

Choose Resync when manual service resynchronization is
triggered from Cisco DNA Center to one or more SDG
agents.

Resync

Choose Withdraw to collect information when the source
SDG agent sends a service withdrawal message to prevent
global distribution.

Withdraw

Choose Cache Clear to collect logs for all service
withdrawal messages from the SDG agent with a manual
CLI step.

Cache Clear

Choose Salut for initial communication messages between
the SDG agent and Cisco DNA Center.

Salut
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A P P E N D I X A
Configure SDG Agents and Service Peers
Through the Cisco DNA Center Template Editor
Tool

• About SDG Agent and Service Peer Configuration Through the Cisco DNA Center Template Editor
Tool, on page 103

• Tag Cisco Catalyst and Cisco Nexus SDG Agent Switches, on page 103
• Build Bonjour Policy CLI Templates, on page 104
• Create a Cisco Catalyst and Cisco Nexus Switch Network Profile, on page 115
• Provision Cisco Service Discovery Gateway Bonjour Policies, on page 117

About SDG Agent and Service Peer Configuration Through the
Cisco DNA Center Template Editor Tool

The Cisco Wide Area Bonjour application on Cisco DNA Center does not push configurations to the SDG
agent switches or service peer devices automatically. The SDG agents and service peers need to be configured
either manually or through templates created by the template editor in Cisco DNA Center.

This section explains how to create templates for deploying SDG agents and service peers. The exact IP
addresses, VLANs, and service types used in the template vary based on the deployment. You can add or
remove service types as necessary.

Tag Cisco Catalyst and Cisco Nexus SDG Agent Switches
You can create a tag and apply it to your SDG agents to make it easy to identify the switches when selecting
templates to apply to them.

Step 1 Click the menu icon ( ) and choose Provision > Inventory.
Step 2 Check the associated check box to choose the SDG agents that you want to tag.
Step 3 Click Tag Device.

The following image shows the Tag Device drop-down list.

Cisco Wide Area Bonjour Application on Cisco DNA Center User Guide, Release 2.3.3
103



Step 4 From the drop-down list, choose the tag with which you want to tag the selected SDG agent.

If you need to create a tag, complete the following steps:

a. Click Create New Tag.

b. Enter the name of the tag and an optional description.

The following image shows the filled-in Create New Tag screen.

c. (Optional) To set device selection rules, expand the Device Selection Rules section.

d. Click Save.

The tag is created.

Step 5 Click Apply.

The tag is applied to the selected SDG agents.

Build Bonjour Policy CLI Templates
The following sections provide information about the various tasks to build Bonjour policy CLI templates.
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Configure SDG Agents and Service Peers for Traditional Routed Access
Networks

Step 1 From Click the menu icon ( ) and choose Tools > Template Editor.
Step 2 In the Template Editor in Cisco DNA Center, click the settings icon to the right of a Day-N project.
Step 3 From the drop-down list, click Add Template.
Step 4 In the Add New Template screen, under Template Type, choose Regular Template.
Step 5 Enter a Name and Description for the template.
Step 6 Enter a tag for the switches to which the template needs to be added.
Step 7 Choose the Device Type to which the template will be applicable.
Step 8 Enter the Software Type.
Step 9 Click Add.
Step 10 Under the Provision page, choose the project under which the newly created template exists.
Step 11 Click the template name.
Step 12 In theTemplate screen, enter the CLI commands that the template needs to push to the SDG agent switches and service

peer devices.

The following is a sample set of CLI commands:
mdns-sd gateway
rate-limit 100
!
mdns-sd service-list INGRESS-SERVICE-LIST IN
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-window-fileshare
match apple-continuity
!
mdns-sd service-list WIDE-AREA-SERVICE-LIST OUT
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!

mdns-sd service-policy LOCAL_AREA_POLICY
service-list INGRESS-SERVICE-LIST IN
service-list EGRESS-SERVICE-LIST OUT
!

mdns-sd service-list EGRESS-SERVICE-LIST OUT
match apple-tv
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match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!

mdns-sd service-policy WIDE_AREA_POLICY
service-list WIDE-AREA-SERVICE-LIST OUT
!

service-export mdns-sd controller DNAC
controller-address <DNAC IP>
controller-service-policy WIDE_AREA_POLICY OUT
controller-source-interface Loopback0
!

vlan configuration 101-103
mdns-sd gateway
service-policy LOCAL_AREA_POLICY
active-query timer 60
source-interface Vlan4001
transport both
service-mdns-query ptr
!

You can apply or delete match <service-type> statements in the service-lists according to your deployment
requirements.

Replace the VLAN with one or more VLANs that are specific to your deployment.Note

Step 13 In the Actions drop-down menu, click SAVE.
Step 14 In the Actions drop-down menu, click COMMIT.

The Template Editor provides the additional flexibility of customizing templates in multiple ways. You can use template
variables and provision-time (text or form-based) data input. For more information about working with the Template
Editor tool, see the Cisco DNA Center User Guide.

Configure SDG Agents on Traditional Multilayer Networks

Step 1 Click the menu icon ( ) and choose Tools > Template Editor.
Step 2 In the Template Editor in Cisco DNA Center, click the settings icon to the right of Day-N project.
Step 3 From the drop-down list, click Add Template.
Step 4 In the Add New Template screen, under Template Type, choose Regular Template.
Step 5 Enter a Name and Description for the template.
Step 6 Enter the tag for the switches to which the template needs to be added.
Step 7 Choose the Device Type to which the template applies.
Step 8 Enter the Software Type.
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Step 9 Click Add.
Step 10 Under the Provision page, choose the project under which the newly created template exists.
Step 11 Click the template name.
Step 12 In the Template screen, enter the CLI commands that the template needs to push to the SDG agent switches.

The following is a sample set of CLI commands.
mdns-sd gateway
rate-limit 100
!
mdsn-sd service-list INGRESS-SERVICE-LIST IN
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!
mdns-sd service-list EGRESS-SERVICE-LIST OUT
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!
mdns-sd service-list WIDE-AREA-SERVICE-LIST OUT
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!

mdns-sd service-policy LOCAL_AREA_POLICY
service-list INGRESS-SERVICE-LIST IN
service-list EGRESS-SERVICE-LIST OUT
!
mdns-sd service-policy WIDE_AREA_POLICY
service-list WIDE-AREA-SERVICE-LIST OUT
!
service-export mdns-sd controller DNAC
controller-address <DNAC IP>
controller-service-policy WIDE_AREA_POLICY OUT
controller-source-interface Loopback()
!

vlan configuration 101-103
mdns-sd gateway
!
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You can add or delete match <service-type> statements in the service-lists according to your deployment requirements.

Replace the VLAN with one or more VLANs that are specific to your deployment.Note

Step 13 In the Actions drop-down menu, click SAVE.
Step 14 In the Actions drop-down menu, click COMMIT.

The Template Editor provides the additional flexibility of customizing templates in multiple ways. You can use template
variables and provision-time (text or form-based) data input. For more information about working with the Template
Editor tool, see the Cisco DNA Center User Guide.

Configure Service Peers on Traditional Multilayer Networks

Step 1 Click the menu icon ( ) and choose Tools > Template Editor.
Step 2 In the Template Editor in Cisco DNA Center, click the settings icon to the right of a Day-N project.
Step 3 From the drop-down list, choose Add Template.
Step 4 In the Add New Template screen, under Template Type, choose Regular Template.
Step 5 Enter a Name and a Description for the template.
Step 6 Enter the tag for the switches to which the template needs to be added.
Step 7 Choose the Device Type to which the template applies.
Step 8 Enter the Software Type.
Step 9 Click Add.
Step 10 Under the Provision page, choose the project under which the newly created template exists.
Step 11 Click the template name.
Step 12 In the Template screen, enter the CLI commands that the template needs to push to the service peer devices.

The following is a sample set of CLI commands.
mdns-sd gateway
mode service-peer
rate-limit 100
!
mdns-sd service-list INGRESS-SERVICE-LIST IN
match apple-tv
match printer -ipp
match printer -ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!
mdns-sd service-list EGRESS-SERVICE-LIST OUT
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
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match apple-screen-share
match apple-rdp
match pinter-lpd
match apple-windows-fileshare
match apple-continuity
!

mdns-sd service-policy LOCAL_AREA_POLICY
service-list INGRESS-SERVICE-LIST IN
service-list EGRESS-SERVICE-LIST OUT
!

vlan configuration 101-103
mdns-sd gateway
service-policy LOCAL_AREA_POLICY
active-query timer 60
source-interface Vlan4001
service-mdns-query ptr
transport both
sdg-agent 40.1.1.1
!

You can add or delete match <service-type> statements in the service-lists according to your deployment requirements.

Replace the VLAN with one or more VLANs that are specific to your deployment.Note

Step 13 In the Actions drop-down menu, click SAVE.
Step 14 In the Actions drop-down menu, click COMMIT.

The Template Editor provides the additional flexibility of customizing templates in multiple ways. You can use template
variables and provision-time (text or form-based) data input. For more information about working with the Template
Editor tool, see the Cisco DNA Center User Guide.

Configure SDG Agents on Distributed Anycast Gateway Without Service Peers

Step 1 Click the menu icon ( ) and choose Tools > Template Editor.
Step 2 In the Template Editor in Cisco DNA Center, click the settings icon to the right of a Day-N project.
Step 3 From the drop-down list, choose Add Template.
Step 4 In the Add New Template screen, under Template Type, choose Regular Template.
Step 5 Enter a Name and Description for the template.
Step 6 Enter the tag for the switches to which the template needs to be added.
Step 7 Choose the Device Type to which the template applies.
Step 8 Enter the Software Type.
Step 9 Click Add.
Step 10 Under the Provision page, choose the project under which the newly created template exists.
Step 11 Click the template name.
Step 12 In theTemplate screen, enter the CLI commands that the template needs to push to the SDG agent switches and service

peer networks.

The following is a set of sample CLI commands.
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mdns-sd gateway
rate-limit 100
!
mdns-sd service-list INGRESS-SERVICE-LIST IN
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!
mdns-sd service-list EGRESS-SERVICE-LIST OUT
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!
mdns-sd service-list WIDE-AREA-SERVICE-LIST OUT
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!

mdns-sd service-policy LOCAL_AREA_POLICY
service-list INGRESS-SERVICE-LIST IN
service-list EGRESS-SERVICE-LIST OUT
!
mdns-sd service-policy WIDE_AREA_POLICY
service-list WIDE-AREA-SERVICE-LIST OUT
!
service-export mdns-sd controller DNAC
controller-address <DNAC IP>
controller-service-policy WIDE_AREA_POLICY OUT
controller-source-interface Loopback0
!

vlan configuration 101-103
member evpn-instance 1 vni 10001
mdns-sd gateway
service-policy LOCAL_AREA_POLICY
active-query timer 60
source-interface Vlan4001
transport both
service-mdns-query ptr
!

You can add or delete match <service-type> statements in the service-lists according to your deployment requirements.
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Replace the VLAN with one or more VLANs that are specific to your deployment.Note

Step 13 In the Actions drop-down menu, click SAVE.
Step 14 In the Actions drop-down menu, click COMMIT.

The Template Editor provides the additional flexibility of customizing templates in multiple ways. You can use template
variables and provision-time (text or form-based) data input. For more information about working with the Template
Editor tool, see the Cisco DNA Center User Guide.

Configure SDG Agents on a Distributed Anycast Gateway with a Service Peer

Step 1 Click the menu icon ( ) and choose Tools > Template Editor.
Step 2 In the Template Editor in Cisco DNA Center, click the settings icon to the right of a Day-N project.
Step 3 From the drop-down list, choose Add Template.
Step 4 In the Add New Template screen, under Template Type, choose Regular Template.
Step 5 Enter a Name and Description for the template.
Step 6 Enter the tag for the switches to which the template needs to be added.
Step 7 Choose the Device Type to which the template applies.
Step 8 Enter the Software Type.
Step 9 Click Add.
Step 10 Under the Provision page, choose the project under which the newly created template exists.
Step 11 Click the template name.
Step 12 In the Template screen, enter the CLI commands that the template needs to push to the SDG agent switches.

The following is a sample set of CLI commands.
mdns-sd gateway
rate-limit 100
!
mdns-sd service-list INGRESS-SERVICE-LIST IN
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!
mdns-sd service-list EGRESS-SERVICE-LIST OUT
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
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match apple-windows-fileshare
match apple-continuity
!
mdns-sd service-list WIDE-AREA-SERVICE-LIST OUT
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!

mdns-sd service-policy LOCAL_AREA_POLICY
service-list INGRESS-SERVICE-LIST IN
service-list EGRESS-SERVICE-LIST OUT
!
mdns-sd service-policy WIDE_AREA_POLICY
service-list IDE-AREA-SERVICE-LIST OUT
!
service-export mdns-sd controller DNAC
controller-address <DNAC IP>
controller-service-policy WIDE_AREA_POLICY OUT
controller-source-interface Loopback0
!

vlan configuration 101-103
member evpn-instance 1 vni 10001
mdns-sd gateway
!

You can add or delete match <service-type> statements in the service-lists according to your deployment requirements.

Replace the VLAN with one or more VLANs that are specific to your deployment.Note

Step 13 In the Actions drop-down menu, click SAVE.
Step 14 In the Actions drop-down menu, click COMMIT.

The Template Editor provides the additional flexibility of customizing templates in multiple ways. You can use template
variables and provision-time (text or form-based) data input. For more information about working with the Template
Editor tool, see the Cisco DNA Center User Guide.

ConfigureServicePeersonaDistributedAnycastGatewayMultilayerNetwork

Step 1 Click the menu icon ( ) and choose Tools > Template Editor.
Step 2 In the Template Editor in Cisco DNA Center, click the settings icon to the right of the Day-N project.
Step 3 From the drop-down list, choose Add Template.
Step 4 In the Add New Template screen, under Template Type, choose Regular Template.
Step 5 Enter a Name and a Description for the template.
Step 6 Enter the tag for the switches to which the template needs to be added.
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Step 7 Choose the Device Type to which the template applies.
Step 8 Enter the Software Type.
Step 9 Click Add.
Step 10 Under the Provision page, choose the project under which the newly created template exists.
Step 11 Click the template name.
Step 12 In the Template screen, enter the CLI commands that the template needs to push to the service peer devices.

The following is a sample set of CLI commands:
mdns-sd gateway
mode service-peer
rate-limit 100
!
mdns-sd service-list INGRESS-SERVICE-LIST IN
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!
mdns-sd service-list EGRESS-SERVICE-LIST OUT
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match appler-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!

mdns-sd service-policy LOCAL_AREA_POLICY
service-list INGRESS-SERVICE-LIST IN
service-list EGRESS-SERVICE-LIST OUT
!

vlan configuration 101-103
mdns-sd gateway
service-policy LOCAL_AREA_POLICY
active-query timer 60
source-interface Vlan4001
service-mdns-query ptr
transport both
sdg-agent 40.1.1.1
!

You can add or delete match <service-type> statements in the service-lists according to your deployment requirements.

Replace the VLAN with one or more VLANs that are specific to your deployment.Note

Step 13 In the Actions drop-down menu, click SAVE.
Step 14 In the Actions drop-down menu, click COMMIT.
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The Template Editor provides the additional flexibility of customizing templates in multiple ways. You can use template
variables and provision-time (text or form-based) data input. For more information about working with the Template
Editor tool, see the Cisco DNA Center User Guide.

Configure SDG Agents on a Centralized Gateway Network

Step 1 Click the menu icon ( ) and choose Tools > Template Editor.
Step 2 In the Template Editor in Cisco DNA Center, click the settings icon to the right of a Day-N project.
Step 3 From the drop-down list, choose Add Template.
Step 4 In the Add New Template screen, under Template Type, choose Regular Template.
Step 5 Enter a Name and Description for the template.
Step 6 Enter the tag for the switches to which the template needs to be added.
Step 7 Choose the Device Type to which the template applies.
Step 8 Enter the Software Type.
Step 9 Click Add.
Step 10 Under the Provision page, choose the project under which the newly created template exists.
Step 11 Click the template name.
Step 12 In the Template screen, enter the CLI commands that the template needs to push to the SDG agent switches.

mdns-sd gateway
ingress-client query-supression enable
rate-limit 100
!
mdns-sd service-list INGRESS-SERVICE-LIST IN
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!
mdns-sd service-list EGRESS-SERVICE-LIST OUT
match apple-tv
match printer-ipp
match printer-ipps
match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!
mdns-sd service-list WIDE-AREA-SERVICE-LIST OUT
match apple-tv
match printer-ipp
match printer-ipps
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match apple-airprint
match web-server
match apple-screen-share
match apple-rdp
match printer-lpd
match apple-windows-fileshare
match apple-continuity
!

mdns-sd aervice-policy LOCAL_AREA_POLICY
service-list INGRESS-SERVICE-LIST IN
service-list EGRESS-SERVICE-LIST OUT
!
mdns-sd service-policy WIDE_AREA_POLICY
service-list WIDE-AREA-SERICE-LIST OUT
!
service-export mdns-sd controller DNAC
controller-address <DNAC IP>
controller-service-policy WIDE_AREA_POLICY OUT
controller-source-interface Loopback0
!

vlan configuration 101
member evpn-instance 1 vni 10001
!
interface vlan 101
mdns-sd gateway
service-policy LOCAL_AREA_POLICY
active_query timer 60
transport both
!

You can add or delete match <service-type> statements in the service-lists according to your deployment requirements.

Replace the VLAN with one or more VLANs that are specific to your deployment.Note

Step 13 In the Actions drop-down menu, click SAVE.
Step 14 In the Actions drop-down menu, click COMMIT.

The Template Editor provides the additional flexibility of customizing templates in multiple ways. You can use template
variables and provision-time (text or form-based) data input. For more information about working with the Template
Editor tool, see the Cisco DNA Center User Guide.

Create a Cisco Catalyst and Cisco Nexus Switch Network
Profile

With Cisco DNA Center, you can create a network profile for SDG agents and assign templates to them. This
step creates a network profile for the SDG agents, and assigns both the templates created in the previous steps
to the template. The network profile will be used to provision the SDG agents later.

Step 1 Click the menu icon ( ) and choose Design > Network Profiles.
Step 2 Click Add Profile and choose Switching.
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The following window is displayed.

Step 3 Click the Day-N Template(s) tab.
Step 4 Click Add.
Step 5 From the drop-down lists, choose the Device Type, Device Tag, and Template for the network profile that you want to

create.

Step 6 To add another template, click Add.
Step 7 Click Save.
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Provision Cisco Service Discovery Gateway Bonjour Policies
Provisioning the Cisco SDG Bonjour policies pushes the CLI configurations of the two templates assigned
to the network profile, enabling the switch to process Bonjour announcements and queries, and to forward
them to the Wide Area Bonjour Controller.

Step 1 Click the menu icon ( ) and choose Provision > Inventory.
Step 2 Check the check box of the device to provision.
Step 3 From the Actions drop-down list, choose Provision > Provision Device.
Step 4 Enter the details of the site and click Next.
Step 5 Choose the devices for which to fill out the provisioning parameters and click Next.
Step 6 Review the details and ensure that both the required templates are listed under Template Name, then click Deploy.
Step 7 Choose Now to provision the template immediately, or choose Later to schedule the provisioning for a later date.
Step 8 Click Apply.

You can monitor the provisioning status from the Inventory page with the Focus set to Provision.
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